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Documentation Updates

The title page of this document contains the following identifying information:

e Software Version number, which indicates the software version.
¢ Document Release Date, which changes each time the document is updated.
e Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

e Search for knowledge documents of interest

e Submit and track support cases and enhancement requests
e Download software patches

e Manage support contracts

e Look up HP support contacts

¢ Review information about available services

o Enterinto discussions with other software customers

e Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.htmi
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help

This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Chapter 1

Overview of File System Viewer

File System Viewer helps you to understand if your file storage infrastructure is growing in a
managed, organized, and efficient manner. File System Viewer creates an information store about
your storage system.

By combining file, logical, and physical storage resource monitoring and reporting with active SAN
management, File System Viewer provides a single integrated system for managing your entire file
storage infrastructure.

Use File System Viewer to obtain detailed information about file servers and volumes across your
network. You can get summary information about your files from across your enterprise to a
specific file server or volume.

File System Viewer can help you with answering the following questions.

Overall View — Dashboard

e How do | obtain an overview of the following statistics?

= Top five file servers by scanned space
= Top 10 file extensions by size or count
= Top five file extensions
= Accessed age distribution by usage or count
e The usage is the total size of all the files with the particular extension.
e The count is the number of files with the particular extension.
Composition — Aging, Size
e Why are there files on a system that has not been accessed for more than six months?
e What is the size group distribution on various file systems?

¢ Dowe need hierarchical storage management or a store and delete policy?

Content — Extensions

¢ Arefile systems being used properly?
¢ |s there misuse of storage space?

o |[f there is misused space, who are the offenders?

Consumer — Users, Ownership, Applications
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Who is using how much space?

Is the usage planned?

Capacity — Used and Available

What is the total available capacity?

How much is being used?

File System Viewer does a recursive lookup on the file system and stores the information in an
embedded database. File System Viewer can scan files very quickly because File System Viewer
never opens the files.

You can use UNC shares to discover file system data from a server. To scan UNC volumes, you
must define them in a UncShares.xml file. For details, see "Defining UNC Volumes" on page 42.

Caveats with Using File System Viewer

Keep in mind the following when using File System Viewer:

The maximum number of threads File System Viewer can use is 15.

If you do not see information for the file server, verify that the collector for the file server is
running. You can verify this by selecting Configuration > File System Viewer. On the Scan
Schedule tab, look in the Running? column. See "Working with Scans and Schedules in File
System Viewer" on the next page.

File System Viewer is able to detect duplicate files only within a storage volume. File System
Viewer cannot detect duplicate files that exist on different volumes. For example, if you have a
duplicate file on two different storage volumes, File System Viewer is not able to detect the
duplicate file.

If you plan to have File System Viewer scan a host, make sure you have 80-120 MB for each set
of one million files. The actual size depends on the length of the file names.

If you want to use File System Viewer bulk import capability for non-ASCII characters (Chinese,
Japanese, Korean), the file should be created with UTF-8 encoding. Tools such as Notepad let
you specify the encoding in the “Save As” dialog.

Reparse points (junctions) for file servers on Microsoft Windows are scanned. For example,
assume you create a junction named C:\DDrive that points to the root of the D drive. The
content of the D drive is available under C:\DDrive. After a scan, information on capacity and
amount used is displayed for the C drive. However, the sum of the file sizes on the C drive also
includes the junction (C:\DDrive), which points to the root of the D drive. If you do not want to
include the scanning of reparse points, see "Enable the Scanning of Reparse Points" on page
32. Reparse points created using the Windows Disk Management tool are discovered as a drive
that can be scanned independently.

A storage volume on a member node that is shared as a cluster resource is not managed through
the member node. It is available only from the cluster. The File System Viewer scheduler user
interface does not list cluster shared volumes of a member node.

To scan an entire volume, the credentials used to discover the host or the credentials provided to
scan the volume must have read access to the entire directory structure of that volume.
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Setting up File System Viewer

To obtain information about your file servers and volumes, you must do the following:

1. Discover the host as described in “Step 1 — Discovering Your Hosts and Backup Manager
Hosts” in the Installation Guide or User Guide.

2. Make File System Viewer aware of the file servers it needs to scan, as described in "Adding
File Servers for File System Viewer to Scan" on the next page. Then, scan the file servers.

You will not see data in File System Viewer until you complete this step.

3. Create schedules for scans, as described in "Working with Scans and Schedules in File
System Viewer" below.

4. Import user information as described in "Importing User Information from LDAP and Active
Directory Servers" on page 27.

5. Create rules for gathering file server information, as described in "Working with Rules for
Gathering File Server Information" on page 33.

6. Enabling the collection of ACL data, as described in "Enabling the Collection of Access Control
Entry Data Collection for Directories on Windows Servers" on page 40.

You will not see data in the Trustee view until you complete this step.

Working with Scans and Schedules in File
System Viewer

The File System Viewer simplifies the process of specifying file servers for scan schedules and for
working with the scan schedules. The following is the File System Viewer main page displaying a
list of file servers.

File Servers m Scan Status | Report Rules m Effective Utilization Index

Create or View File Servers and set-up File Scans:

Actions such as Adding or Deleting File Servers, setting Volume Specific Credertials, Scheduling Interval Based Scans, Deleting Yolume Data, Test Scans and Stop Scans can be performed,

m Delete Volume Data... Schedule Multiple File Servers... Delete
Select Operating System or spscity the File Server Name or both and apply Fiter button to list the fils servers
Fiter by 05| Al ™| File Server Name: | m
List of File Servers
o e
[ bpmedia  Solaris Generic_117350-02.5.8 Select v

[ @ainzke  Windows Server(R) 2008 €.0.6001 Select v

[0 WUMNAMDT Windows Select ~

The File Servers tab displays a List of file servers from which you can choose a specific server.
You can select the following actions in the associated pull-down menus: Select, Add Schedule,
Credentials, Scan Now, and Stop Scan.

Page 12 of 112 HP Storage Essentials (9.70)



File Servers Guide
Chapter 1: Overview of File System Viewer

The screen enables you to filter by operating system, file server name, or both. The screen contains
three buttons located across the upper part of the page:

e Add File Server — Adds afile server.

e Schedule Multiple File Servers — Opens a wizard to schedule more than one file server at a
time.

¢ Delete — Deletes more than one file server at a time. You will see a confirmation page before the
deletion occurs.

The screen displays a list of file servers, including name, operating system and version, and
whether afile server is part of a cluster. Associated pull-down menus (in the Action column) enable
you to select the following actions for selected file servers:

¢ Add Schedule — Opens the Add Schedule wizard to enable the addition of a new File Server
Viewer schedule. Only one schedule can be added for file servers on hosts with agents prior to
6.0.

e Credentials — Starts a wizard that enables you to specify the credentials to be used for scan
volumes on the file server. This functionality is supported for CIFS shares on Windows file
servers, and all types of volumes for UNIX file servers that are supported by File Server Viewer.

e Scan Now - Enables you to perform a “run once” scan on a selected set of volumes on a
specified file serverimmediately.

e Stop Scan - Stops all the File Server Viewer scans currently running on the file server, but does
not stop the schedule.

e Test Scan — Enables you to perform Test Scan functionality. The feature is not available for file
servers on virtual cluster hosts. See "Performing a Test Scan" on page 26.

¢ Delete File Server (icon) — Deletes the File Server Application created on the host and deletes
all File Server Viewer information collected on the file server.

Other tabs on the File System Viewer main screen include the following:

e Scan Schedule — Displays the screen used to set up and associate scan schedules to a
selected file server. Functions available at the Scan Schedule screen include the Start and Stop
scan buttons, Edit the schedule, and Delete (for individual file server schedule deletion and for
deleting all the selected file server schedules).

e Scan Status — Provides information about the status of the most recent scan on each of the
configured volumes.

¢ Report Rules —Displays the screen used to set up the rules for creating reports for specific
needs.

Adding File Servers for File System Viewer to Scan

You must make File System Viewer aware of file servers it needs to scan if you want to see
information from your file servers.

File System Viewer does not scan the volumes with file system of type “GPFS” on HACMP
clusters.

Cluster shared resources on file server member nodes are not displayed on the Topology tab.
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File servers can only be created on hosts that have non-null as the operating system value.
To add file servers to scan:

1. Click Add File Server on the File System Viewer main page (Configuration > File System
Viewer).
The Add File Server button displays a list of available file servers that support File System
Viewer. Data collection must be enabled on these file servers.

2. From the displayed list of available file servers, add file servers by selecting the check boxes
for the file servers and clicking OK.
File servers that are part of a host cluster are marked accordingly in the Is Cluster column of
the list.

Deleting Volume Data

You can delete the file system specific data of a scanned volumes so that the volume would be
similar to an unscanned volume. The volume would also be removed from the scan schedule and
any report rule mappings. If all volumes in a schedule are deleted, the schedule is also deleted.

Data from volumes currently being scanned would not be deleted. You can tell if a volume is
currently being scanned because it will have a scan status of one of the following:

Scan started

Scan in progress

Transferring

File uploading

The volume with # symbol denotes that the volume was scanned before it was assigned as a
cluster volume through the Build Cluster. This volume data is removed because it is not shown in
any FSV page.

To delete volume data:
1. Click Configuration > File System Viewer.
Click the File Servers tab.
Click Delete Volume data.
Click the Show Available Volumes link if the volumes are not displayed.

Click the Show Filter link if the filter is not displayed.

2 T

In the Select OS field, select the operating system for the file server or select all to display all
file servers. The file servers meeting the criteria of the Select OS field are displayed in the
Select File Server window.

7. Inthe Select File Server window, select a file server. The name of the file server is displayed in
the File Server Name field.

8. Click Go. HP Storage Essentials displays the volumes on the selected file server in the pane
below.
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9. Select the volumes you want to delete and click Add Selected Volumes to Delete Data. The
selected volumes are displayed in the Selected Volumes table. Volumes that are in the
Selected Volumes table are reverted to the status of an unscanned volume when the Finish
button is clicked.

10. Toremove a volume from the Selected Volumes table, select the volume and click Remove
Selected Volumes form Deleting Data.

11. Click Finish. Volumes in the Selected Volumes table are reverted to the status of an
unscanned volume.

Scheduling Single and Multiple Scans

You can create single scan and multiple scan schedules for a file server. The multiple scan
schedule feature enables you to schedule scans of different volumes at different intervals and at
different start times. However, you can add only one schedule for file servers on hosts with agents
prior to 6.0.

To begin configuring for single or multiple scans, you must first declare the intended host a file
server, and then you use the Add Schedules wizard to create the schedules for the intended file
server.

Adding a Schedule

On the File System Viewer Main page (File Servers tab), locate the file server on which you want to
set up the scan schedule.

To add a schedule:
1. Select Add Schedule from the pull-down menu choices (in the Action column).

2. Select the Create Schedule wizard, which opens and displays a screen similar to the
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following:

File Server FSRM-1
Avadlable Volumes

ESAL-1 Local Disk

E] FERM.1 — I NTFS Local Dk

B Fsmu-a =2 NTFS Local Digx
F FERM-1 = NTFS listwrork Drive
B FsRu-1 = - NTFS lostwerk Drive
| B FERML1 =2y NTFS Kestwork Drive

Selecied Volumes

B e A

Swabwme  |[zoeresziises | OB
riereat i [weskiay )|

Tresad Count |1

The wizard contains two volume lists:

¢ Auvailable Volumes — Shows volumes available for scheduling
e Selected Volumes — Shows volumes selected for scan

The lower part of the display contains scan schedule information (start date and time, interval for
the scan). The display also shows the number of threads, representing the number of parallel scans
to be performed for this schedule. The minimum value for the field is 1. Start time cannot be earlier
than the current time. Thread count cannot be more than the number of volumes.

Volumes can be selected for inclusion in a schedule by selecting the corresponding check boxes
and clicking the Add button. This removes the selected volumes from the Available Volumes table
and adds them to the Selected Volumes table.

You can correct inadvertent selections by clicking the Delete button below the selected volumes
table. This moves the corresponding volumes from the Selected Volumes table to the Available
Volumes table.

Each volume can be individually configured. The options for each volume in the Selected Volumes
table are:
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¢ Volume specific exclude directory list
The default exclude directory list is based on the value of the JBOSS property
fileSrm.excludeDirectories.

Scanning of a directory in the exclude directory list skips collections if the directory exists in the
root of the volume. If a directory of the same name exists at any other level, that directory is
scanned.

e Option to collect ownership

e Option to map users to ownership. The option is enabled only if the ownership collection is
selected.

e Option to collect ACL information for Windows file server

When a schedule is saved, changes to the properties do not affect already saved schedules. All
schedules can be viewed and edited in the Scan Schedules page.

Excluding Volumes from Scanning of File
Extension Details

If you have volumes with more than two million files, you might want to decrease the scanning time
by excluding volumes with many files from the scan.

File extension details are not collected for the volumes specified in the
fileSrm.volumesToSkipExtensionsGathering property; for example:

fileSrm.volumesToSkipExtensionsGathering=10000,10001

In this instance, 10000 and 10001 are volume IDs for the volumes that are designated to be
excluded. The property can be found in Configuration > Product Health > Advanced > Default
Properties.

Skipping collection of file extensions could affect the way file extensions are displayed in the drill-
down menus of the product. The information displayed for the file extensions on excluded volumes
could be missing or outdated.

Credentials

You can specify or edit the credentials used by the File Server Viewer to scan volumes on the File
Server Viewer. To assign or clear credentials, select Credentials from the pull-down menu choices
(in Action column).
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T} Assign, Modify or Clear credentials. - Microsoft Intemet Explorer provided by Hewlett-Packard

File Server DEVCLUSTER-234
Assign, Modify or Clear credentials for accessing a volume for performing file scan.

The scan runs by default a5 LocalSystem on Windows and as root in Unix fie servers,
except for Windows Network Drives where by defaull the Host discovery credentials are used.

Available Volumes

v/ \E:‘:'x :::.. Drive Type User Hame Edit

| & S NTFS Local Disk
V¥ S NTFS Local Disk

e — NTES External Drive sa B¢
¥ D NTFS External Drive 53 [ETa
¥ S NTFS External Drive sa Qf

|

You can assign credentials, clear credentials, and edit credentials. To assign credentials to a given
set of volumes, choose the volume and select the Assign Credentials button.

You can edit or clear credentials fora UNC share volume. However, doing this on a Windows-
based system does not prevent running further successful scans on the volume. Windows allows
you to run a successful scan on that volume, even though the credentials for it were edited or
cleared.

You can assign (specify) the user name and password to use for scanning the volume.

File Server FSRM-1

User Name: ||

Password:

Verify Password: [ ]
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Enter the user name and password, and then click OK. The credentials are saved into the database
after the wizard completes.

Edit Credentials

The Edit Credentials screen enables you to change a user name and password previously
assigned.

File Server FSRM-1
Volume E;

User Name: sfad|
Password:

Werify Password: |

The associated volume is shown in the header. Enter the new credentials and then select OK.

Scan Now

Select the Scan Now pull-down menu choice (Action column) to perform an immediate scan on a
given set of volumes. The wizard and functionality are similar to configuring an interval-based scan,
except that the start time and interval are not required.
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File Server FSRM-1
Available Volumes

EICES I =
Volume
= S NTFS

FERLL Local Disk
[F FsAMaa =0 NTFS Local Disk
[#] FsAMA S NTFS Local Disk
[#] F3AMA =1 NTFS Pistwork Drive
[#] F3AM ST NTFS Metwork Drive
[#] FsRM-1 (=1 NTFS Materork Drive

Selected Volumes
File Gerver Slorage | FileSysle

W comect n User Ta
e Tree Trpe Blap Exclude Durectories Remave

Thread Count: |1

[ ox || concet | new

The @ symbol appended to the drive name indicates that the volume is scheduled for a scan in an
interval schedule. The Thread Count feature enables you to specify the number of parallel scans to
be run in the schedule.

The Scan Now option creates a “run once” schedule, which is not stored for future use. Exercise
caution when using the Scan Now option, because a scheduled scan could already be in process at
the instant that a forced scan is invoked. In such a situation, the volumes being scanned, or the
volumes currently in the scan queue, are omitted from the new scan request.

Schedule for Multiple File Servers (Multiple Scans)

The Schedule Multiple File Servers button on the main FSRM display page, File Servers tab,
provides functionality similar to the Add Schedule button. It also provides the additional capability to
create multiple schedules across multiple file servers. Selecting the button starts a wizard which
contains two tabs, Available Volumes and Selected Volumes.

Page 20 of 112 HP Storage Essentials (9.70)



File Servers Guide
Chapter 1: Overview of File System Viewer

el Giberbivay =i i B e & by Pili DB W o Pob N il

SRS Eare— e
T Saran
T SPNPRAESRPERS Y Saepeep——p—

A

[ 10k LR

o GangaaTEsT P n A Eary e 2003 -

) PEVTLLATERN WP bl Gt JEAS

P b b P &

C rymia Vrem ) Serew 3557

C Da&TH e 1A Sarew 1083

[+ oty L ATIRS S

& Pr —

i Uakia0Ra0 iy WP

¢ [e— [

-

a7 sl i ainta N piReden

g T

g [T W Comen B Craer W . Ta

L] ol Type i Ty PP ¥ ol Fla o

[ &, W LBE D 1 [m] (] B LR e arir el

O ™t yur ik Late e C 2] ] BECTLER. ezt e

M s Vaptarh Drew C =] (=] LER, nracieot g

Ooe, ] Pt Dl C [ 0 EECYTLER, nrapinet —un

0 =, ri i Ll 1 =] B LR BAR -

0 =y i e = C a] R TLER naniieet

[ 5 Veptuarers Drew | [ 0 FECYTLER, memsttrt =

e L o | o ] a

The filter enables you to narrow the list of file servers displayed. After filtering, the File Servers list
shows the list of file servers available for scheduling. Use the corresponding radio buttons to
populate the list of volumes available for scheduling (Storage Volumes table).

Multiple volumes can be selected and configured from the table to be added in the schedule. After
the configuration is finished, select the Add button to confirm the number of volumes selected for
the schedule.

You can repeat the previous steps for other file servers in the File Servers table, or you can filter
new file servers. After you add the volumes for the file servers, select the Next button to open the
Selected Volumes tab display.
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The display shows the volumes added for the various file servers in the Available Volumes tab. The
Selected Volumes tab display does not permit editing volumes. To edit configurations, or remove

volumes, select the Prev button to go back and make the changes.

The Selected Volumes tab displays the date and time, the interval, and the thread count for the
schedules created. After you assign the required values, select the Finish button to create

schedules for the multiple file servers.

The wizard helps you create multiple schedules at the same time. Once submitted, schedules are

created for each file server that was configured.

The thread count for the schedule created is computed with the following formula:

Thread Count = minimum
Count field)

(Number of Volumes Selected,

value in Thread

Warning and Alert for Deleted Volumes

When you select drives for a particular host, they show as selected (on the Configuration File
Viewer page) for a period of time (one day, 12 hours, etc.). When the drives no longer display as
selected after that period of time, a warning icon appears for those schedules that are partially or

fully affected.

When you click the warning icon, an alert message appears. The message content depends on
whether the volumes are partially or fully affected. Message contents are the following:

o All volumes affected — Assume a schedule contains five volumes and are all deleted in the
database. If you click on the warning icon that appears, an alert message similar to the following

appears:

Storage volumes scheduled for a scan in this task either do not

exist now,
scanned now.
a new schedule.

or have changed in the database.

These volumes cannot be
Please click the Delete icon to delete them and create

¢ Some volumes affected — Assume a schedule contains five volumes and only some of them
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are deleted in the database. If you click the warning icon that appears, then an alert message
similar to the following appears:

Some Storage volumes scheduled for a scan in this task either do not
exist now, or have changed in the database. These volumes cannot be
scanned now. Please click the Edit icon to include them for a scan.

Scan Schedules Tab

The Scan Schedules Tab on the File System Viewer main page lists all the schedules created for
the various file servers:

Data Collectors for File Servers:
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The Start and Stop buttons near the middle of the screen, at the right, can be used as batch
operations to start or stop the selected multiple schedules. The Delete button can be used as a
batch operation to delete selected multiple schedules.

Each schedule lists the file server, volumes selected for scan on the file server, the time the
schedule is invoked next, the interval in minutes, and its status (running or stopped). The display
also contains the following:

e Stop Scan — This button attempts to stop the scan on the volumes selected in the schedule. It
does not stop the schedule and the schedule can run at the next interval. If you want to disable a
schedule, select the Stop button (at the top of the page) after selecting the schedule to be
disabled.

o Delete Schedule icon — Select this icon to delete the schedule. It stops the scan on the
volumes selected for the schedule before the deletion. However, this does not alter any File
Server Viewer data already collected for the volumes in the schedule.

o Edit icon —This starts the Edit wizard, letting you modify the schedule to change the volume list
or its other scan options. Edit is described further in the following paragraphs.

Editing a Scan Schedule

The Edit button enables you to change the scan configuration by changing the volume list for the
scan, changing the start time (next scheduled time to run if one is already started), interval, and
thread count. You can also change volume specific information, such as ownership collection,
mapping users to ownership, exclude directory list, and ACL collection for the Windows file server.
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Clicking the Edit icon starts a wizard. The screen contains two tabs, Available Volumes and
Selected Volumes.

Flig Gervers
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This screen enables you to select volumes available for further addition to the schedule by checking
the corresponding check box. You can also modify the default configuration information for each
volume. After making your selections, select the Add button to confirm your intent to add them to

the schedule.

The Add button does not add the volumes to the schedule yet; it only confirms they are considered

for addition.

After selecting the Add button, select the Next button to open the Selected Volumes tab.
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This display provides a list of volumes for this schedule. You can remove volumes by selecting the
Remove button.

There must be at least one volume in the Selected Volumes tab. You cannot delete the schedule by
simply removing all the volumes from the Select Volumes tab. If you attempt to do so, an alert is
raised.

Scan Status Tab

You can review the status of the current scan or the most recent scan that took place on each of the
volumes on which a scan was started.

To check the status of a scan:
1. Select Configuration > File System Viewer.
2. Click the Scan Status tab.

The following table provides details about the Scan Status tab.
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Column

Heading Description

File Server Displays the name of the file server from which this collector gathers
information.

Volume Displays the volume selected for scanning on a file server.

Scan Start Displays the time that the scan began.

Last Polled If the scanis still in progress or failed, it displays the time of the last scan.

Scan End If the scan is completed, displays the completion time.

Scanned Space

Displays the total size of the files scanned by File System Viewer.

No. Of Files

Displays the number of files that have been scanned.

Current Directory

Displays the directory that is currently being scanned.

Scan Status

The following scan statuses are possible:

¢ NoData

e Scanin Progress

e ScanDone

e Scan Failed

e Transferring Data

e Transfer Completed
e Uploading Data

e Uploading Completed

e Error

Performing a Test Scan

If you changed your network configuration and are not sure the management server can still scan
the server running File System Viewer, you can perform a test File System Viewer scan. During
this scan, the management server verifies that it can access the server and perform a high-level
File System Viewer scan. It also verifies whether or not it can scan network volumes with host
discovery credentials.

Keep in mind the following:

¢ This feature only works with CIM extensions version 5.1 and later.

e Toscan network-mounted drives on a host running Windows, sure a user is logged onto the
Windows host. The user must have permission to mount the network drives. Network drives
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mounted on Windows 2000 hosts are not visible as storage volumes on the Navigation tab orin
the topology.

To perform a test File System Viewer scan:
1. Select Configuration > File System Viewer.

2. Verify that the File Servers tab is selected, and then click Test in the Test Scan column of the
File Servers table.

After you click the Test button, the management server attempts to access the server and perform
a test File System Viewer scan.

Importing User Information from LDAP and
Active Directory Servers

You can enable the automatic population of user details from Active Directory and/or Light weight
direct access protocol (LDAP) servers, so at least the following information is retrieved from
directory services:

e UserName

o Full Name

e Email ID

e Department Number

e User Quota

e User Status™* —for example, Active or Disabled
e Manager*

¢ Home Directory

e Owner

*The User Status and Manager columns are populated when information is imported from an LDAP
server. Users cannot add this information from within HP Storage Essentials.

HP Storage Essentials enables you to import user data from two types of servers:

o Exchange servers — If you already discovered Exchange servers, you can select the servers
from which HP Storage Essentials will import user data. Exchange servers are considered as
LDAP servers in the LDAP Users Collection table.

o LDAP servers —Discover LDAP servers from which you want HP Storage Essentials to import
user data.

You can specify how often user information from the servers listed in the LDAP Users Collection
table is updated.

LDAP Users Collection Table
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The LDAP Users Collection table lists the servers that are designated to be scanned by HP
Storage Essentials for user data. The table provides the following information about an LDAP
server:

Domain — The domain in which the LDAP server resides
Domain controller name — The name of the controller name for the LDAP server

Next Scheduled Run —When HP Storage Essentials will scan the LDAP server again for
updated user information

Interval in Minutes — How often the scan is scheduled to run
Enabled — Checked if collectors are running. Collectors must be running for a scan to run.

Collection status — Lets you know if a scan is currently taking place or if the scan is complete.

You can also do the following:

Edit discovery information for an LDAP server.
Edit the scan schedule for an LDAP server.

Delete an LDAP server from the table. When an LDAP server is deleted from the table, HP
Storage Essentials no longer scans the LDAP server for user information.

Importing User Information from a Discovered
Exchange Domain Server

To import user data from a previously discovered Exchange Domain Server:

1.

3.

Select Configuration > File System Viewer > LDAP Servers and click Add Active
Directory Domain Controller(s).

Select the discovered Exchange Domain Server that contains the user data you want to appear
in HP Storage Essentials.

Click Add and OK. The Exchange Domain server is designated as an LDAP server.

To add a new domain controller:

1.

Select Configuration > File System Viewer > LDAP Servers and click Add Active
Directory Domain Controller(s).

In the Domain box, enter the domain name.
Click the Add New Domain Controller link.

a. Inthe Domain Controller Name box, enter the fully qualified DNS name for the domain
controller.

b. Inthe User Common Name box, enter the Windows logon name or the Common Name
(CN) of the Active Directory User for accessing the Microsoft Exchange server.

c. Inthe Domain Password box, enter the corresponding password for accessing the
Microsoft Exchange server.

d. Inthe Verify Password box, re-enter the password for verification.
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e. Click Add New Domain Controller. The domain controller is added to the table.
f. Click OK.

4. Repeat steps (2) and (3) for each domain controller that you want to add.

Modifying the Collection Schedule for LDAP
Servers

To modify how often user information is gathered an LDAP server:
1. Select Configure > File System Viewer > LDAP Servers.

2. Select the LDAP server for which you want to modify the schedule.

3. Click the Edit Schedule (2 button.

4. Click the calendaricon, @

In the Time box, enter the time in 24-hour format with the hour and minutes separate by a colon;
for example, 22:15. Click the date on which you want the task to run. Today’s date is
highlighted in pink. Click Set.

The date and time appear in the Next Scheduled Run box in the yyyy-mm-dd hh:min format.

If you change the date in the box to a date that does not exist in a month, the software
automatically calculates the date to the next month. For example, if you enter 2010-11-31, the
software assumes the date is 2010-12-01.

6. Inthe Interval box, enter an interval. Select one of the following units from the list:

= Second(s)

= Minute(s)

= Hour(s)

= Day(s)

» Week(s)
7. Click OK.

Editing Discovery Information of LDAP Servers

To edit discovery of LDAP servers:
1. Select Configure > File System Viewer > LDAP Servers.
2. Select the LDAP server you want to edit and its corresponding Edit (Bé') button.
3. Modify the user name and password.

4. Click OK and then click OK again. The product imports user data from the LDAP server.
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About Reports for File System Viewer

Report Optimizer provides a variety of detailed reports for file servers.

Data collectors gather information for reports. If you stop a data collector, its reports are not
updated. You might want to verify that a collector is running if you are having difficulty viewing a
report or you believe the report is not displaying the latest information. See the user guide for more
information.

You can configure File Server SRM to gather specific information by adding rules, deleting rules,
editing rules, and mapping volumes to the rules.

You can create multiple schedules for a single file server, and add and remove volumes to
schedules. A schedule cannot contain volumes (details) for more than one file server, but each file
server can have more than one schedule.

After a successful file server scan, the upload process starts. During this time, extensions, aging
and size groups, and other details are collected. After that, the File Server SRM custom report data
collection begins.

The first part of the process enumerates all rules for the given volume. The process then executes
according to the rules specified.

The reporter reads the results to display the information according to the display criteria specified.

The management server provides reports that display performance information in a variety of
formats:

¢ HTML (default) — The software displays the report in a Web page by default.

o PDF —The software displays the report in Adobe Acrobat, a good option if you need to print the
report. The software assumes you already have Adobe Acrobat Reader installed on your
computer. To obtain a copy of Adobe Acrobat Reader, go to http://www.adobe.com.

e Excel — The software displays the report in Microsoft Excel, providing you have a copy of
Microsoft Excel already installed.

o XML - The software displays the report in the XML format.

Reports could be made of files not accessed in the past n years, files with specific file extensions,
files that exceed a given size, and so on. For example, File Server SRM can group the file
extensions into different categories, so that users can generate reports for the different
applications, such as office-related files (*.doc, *.ppt, *.xls) or music-related files (*.mp3, *.avi).
Supported reports can be used by external reporting tools.

Report information can be filtered. UNIX Global Permissions allows users to filter files into the
report according to rwx permissions. Files with other permissions are present in the report if they
satisfy the selection. For example, the report corresponding to global write permission could contain
files with global execute permission, provided the files also have the global write permission.

The Windows Attributes option enables users tofilter files into the report according to a selected set
of attributes. Only the files that have the selected attributes are collected against the rule
(irrespective of the state of the other attributes). For example, selecting Archive and Encrypted
attributes filters all files that have these attributes. Some of the files in the report might contain files
of other attributes (that is, Hidden), if they have the archive and encrypted attributes.
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Non-ANSI text—for example, Asian characters and the Euro symbol—included in a comma-
separated values file is not displayed properly by Microsoft Excel. Excel replaces the non-ANSI
text with a question mark (?).

Creating Policies for File System Viewer
Users

You can create a utilization policy that generates an event, sends an email, or runs a custom
command when an element is being overused. For example, you can configure Policy Manager so
you receive an email message when the amount of free space on a server decreases to a specified
level.

If you plan to use email notification with your policy, first assign an SMTP server from which the
management server can send its email notifications.

To create a utilization policy for a file server:

1.
2.

10.

11.

Access Policy Manager by clicking the Policy Manager icon in the left pane.

Expand the Policy Manager tree so it displays File Server Users and the users beneath the
node.

Do one of the following:

= To apply the policy to all File System Viewer users, select the File Server Users node.
= To apply the policy to only one File System Viewer user, select that user.

In the right pane, select Add.
Select a policy, and then select Next.

In the Name box on the Policy Properties tab, modify the name of the policy or keep the
default.

In the Description box, modify the description for the policy or keep the default.
In the Re-arm Period box, specify a re-arm period in minutes.

The re-arm period is the amount of time after the policy executes before it can execute again. It
is useful for limiting the number of times the same actions will execute.

You can specify shorter periods forimportant applications.

To the right of the comparison operator menu, enter a percentage or an amount in gigabytes
(GB), depending on the box name displayed.

For trending policies, enter the number of days in the Historic period box (min=7; max=180) and
Projection period box (min=1; max=180).

Select an action to occur when the policy condition is fulfilled by selecting one or more of the
following buttons (more than one action can be assigned to a policy):

= Send E-mail — Policy Manager sends an email when the condition is fulfilled.

Enter a comma-separated list of email addresses, and then select OK.
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= Generate Event — Policy Manager generates an event of the specified event type. The
event appears in Event Manager.

Select one of the following event types:

© Unknown — The severity level is not known.

o Informational — An example of an informational event is a progress report event for
firmware download operation currently in progress.

© Warning — An example of a warning is when one or more new physical fabric objects
(device port, switch, or fabric) have appeared.

© Minor — An example of a minor event is when a physical fabric object (switch port or
fabric) has changed state.

o Major — An example of a major event is when one or more physical fabric objects (device
port, switch, or fabric) have disappeared.

o Critical — An example of a critical event is Brocade switches that have a failed firmware
download and the failure reason code for each respective switch.

Because the severity level for an element is set by the manufacturer, the meanings of the
severity levels vary. It is best to view the description of the event.

After you select an event level, select OK.

12. Execute a Custom Command — Policy Manager executes a custom command on the
management server when the condition is fulfilled. Enter a command that will execute the
script in the box, and then select OK.

The software assumes you areinthe [ Install Dir]
\JBossandJetty\server\appig\remotescripts directory on the management server
when the script is executed. You can use environment variables in your script, such as
POLICY_NAME and POLICY_DESCRIPTION. POLICY_NAME provides the policy name
and POLICY_DESCRIPTION provides the policy description. See “Software Environment
Variables for Scripting” in the User Guide.

Prefix the command with start if the custom command triggers a Ul component, such as a
program that uses the Ul (such as Microsoft Internet Explorer) or a command prompt window.
For example, assume you want the custom command to open a command prompt window and
list the contents in the directory. You would create the following command:

start dir
13. Select Finish.
14. Totest apolicy, select the Test button in the Utilization Policy table.

For more information about editing, deleting, and emailing policies, see the User Guide.

Enable the Scanning of Reparse Points

Reparse points (junctions) for file servers on Microsoft Windows are scanned. For example,
assume you create a junction named C:\DDrive that points to the root of the D drive. The content of
the D drive is available under C:\DDrive. After a scan, information on capacity and amount used is
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displayed for the C drive; however, the sum of the file sizes on the C drive also includes the junction
(C:\DDrive), which points to the root of the D drive.

To enable the scanning of reparse points on Windows file servers:
1. Select Configuration > Product Health, and then select Advanced in the Disk Space tree.
2. Select Show Default Properties at the bottom of the page.

3. Copy the fileSrm.disableReparsePointsScan property. How you copy the text depends on
your Web browser. If you are using Microsoft Explorer or Netscape Navigator, select the text,
right-click the selected text, and then select Copy.

4. Return to the Advanced page (Configuration > Product Health) and select Advanced in the
Disk Space tree).

5. Paste the copied text into the Custom Properties box. How you paste the text depends on your
Web browser. If you are using Microsoft Explorer or Netscape Navigator, right-click the box
and select Paste.

6. Change the value assigned to the fileSrm.disableReparsePointsScan property to false in the
Custom Properties box.

fileSrm.disableReparsePointsScan=false
7. When you are done, select Save.

8. Restart the AppStorManager service for your changes to take effect.

Working with Rules for Gathering File Server
Information

You can create specific rules for the kind of information the system gathers and reports about file
server volumes and directories (rule-based reporting). You do this by adding, deleting, and
assigning rules to selected file server volumes and directories. In addition, you can edit previously
created rules to accommodate changing reporting needs.

The Report Rules tab in the File System Viewer (Configuration > File System Viewer) provides
the user interface and wizards to create and modify these rules.

Report Fules for File Servers:
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Using the buttons and check boxes on this screen, you can Add, Delete, and Edit rules,
Add/Remove volumes associated with the rules, Refresh File Server Reports Cache, and Clear
Data.
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Data collected for the rules is reflected in reports according to the reports refresh schedule. The
Refresh File Server Cache button refreshes the reports cache immediately with data acquired using
latest rules for gathering the data.

The Clear Data button deletes the data collected against a Rule. Clearing the data for a Rule, then
refreshing the reports cache using the Refresh File Server Reports Cache button also removes the
rule’s earlier data from the reports cache.

Add/Remove Volumes

The Add/Remove volumes icon starts a wizard that enables you to map volumes to rules (or
remove them). The wizard has two tabs, Available Volumes and Selected Volumes.

Available Volumes
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From the Available Volumes tab display, use the Filter button to display a list of file servers. Select
the radio buttons to select the volumes from those available for mapping the rules. After making
your selections, click the Add button to confirm the choices selected. You can repeat the process
for other file servers in the table, or click the Filter button to populate a new list.

Select the Next button to open the Selected Volumes tab.
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This wizard helps you map volumes on multiple file servers at the same time. To edit your
selections, select the Prev button. When you are finished, select the Finish button to map volumes
to arule, or select the Remove button to remove them.

The Create Rule Wizard

The Create Rule Wizard lets you create a file server report rule in just a few steps.

e "Step 1 - Create File Server Report Rule" below

e "Step 2—-Add Volumes to the File Server Report Rule" on page 37

Step 1 — Create File Server Report Rule

The Create Rule wizard helps you create report rules for files. The Create Rule wizard opens a page
similar to the following.
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Create File Server Report Rule

Step 1 of 2: Specify Report Rule

Specify report rule propertiss and critsria. Click Hext to continus.

Properties

Rule Nams * Descriptien =
Criteria

Apply this ruleto : (& Fies O Duplicate Fies O Directories

Rule criteria

Select correzponding checkboxes to include the criterion in the rule. Where a range iz allowed, leaving the lower limit blank would be deemed as ne lower limit and leaving the |
would be deemed as no upper limit.

(] File Size

D Last Acceszed

(] Last Modified

D Owned by |(Exam|:|le: Adminiztrator guest)

D Include extenzions |(Exam|:|le: bt exe)

|
|
|
D Created |
|
|
|

D Include directoriez | (Example: WWindows /bazh/core)

Read Qnby Hidden Syztem Archive Device
D Windows Attributes MNormal Temporary Sparze File Reparse point

Comprezsed Offline Not Content Indexed Encrypted
D Unix Global Permizsions Read Write Execute

D Limit Rows

Limit Rows - If limit rows iz checked then only the number of rows specifisd will be fetched.

* required fields

To create rules for files, use the radio buttons to select the files or directories to which the rules will
be applied.

Keep in mind the following:

e Select corresponding check boxes to include the criteria in the rule.

¢ Rule name is mandatory.

o Select the appropriate text box before entering a value; otherwise, text box is disabled.
o By default, all check boxes are unchecked.

e A description is optional.

e Select at least one check box in addition to RULENAME and Limit Rows.
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Maximum value must be greater than the minimum value; for example, File Size >=5 and <=4 is
invalid.

In the “Owned by” text field, you can set single user or multiple users, separated by commas.

In the “Include directories” text field, you can set single directory or multiple directories,
separated by commas.

Enter a value in the “Limit Rows” field to limit the number of rows in the result of rule, such as
100. Otherwise, a generic rule could return a very large number of rows. If no value is entered, all

data is returned. Limit Rows fetches the Top “n” largest from the total result set.

Drop-down choices for sizes shows units for bytes, KB, MB, and GB. The maximum number of
digits allowed is five.

Drop-down choices for days shows units for days, weeks, months, and years. The maximum
number of digits allowed is five. The field accepts a maximum of 43,800 days (120 years) only
after converting the units (weeks, months, years) into days.

Windows Attributes only affects Windows file servers even if a Report Rule is mappedto a
UNIX-type file server.

UNIX Global Permissions only affects UNIX-type servers even if a Report Rule is mapped to
Windows file servers.

When you click Next, the rule is created for all the fields whose check boxes are selected. At the
time of information gathering, the associated rules are applied to the gathering process to collect
the data prescribed by the rule, and to store the data in the database.

When you are done, click Next. See "Step 2 — Add Volumes to the File Server Report Rule" below
for information on how to add and remove volumes from a file server report rule.

Step 2 — Add Volumes to the File Server Report Rule

Select the items in the available volumes table and add them to the report rule volumes table. Then,
click Finished.

To add volumes to a report rule:

1.
2.

Click the Show Filter link if the filter is not displayed.

In the Select OS field, select the operating system for the file server or select all to display all
file servers. The file servers meeting the criteria of the Select OS field are displayed in the
Select File Server window.

In the Select File Server window, select a file server. The name of the file server is displayed in
the File Server Name field.

Click Go. HP Storage Essentials displays the volumes on the selected file server in the pane
below.

Select the volumes you want to add and click Add Selected Volumes to Report Rule. The
selected volumes are displayed in the Selected Volumes table.

To remove volumes from a report rule:
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1. Select the volumes in the Report Rule Volumes table.
2. Click Remove Selected Volumes from Report Rule.

3. Click Finish.

Edit Rule Wizard

You can modify the file server report rules by using the Edit Rule wizard.

e "Edit Rule" below

e "Add or Remove Volumes from a File Server Report Rule" below

Edit Rule

To modify afile server report rule:
1. Click Configuration > File System Viewer.
2. Click the Report Rules tab.
3. Click the corresponding Edit (2¢) button for the file server report rule you want to edit.
The Edit Rule screen lets you change the Rule Criteria and description.
The Rule Name value is disabled. You cannot change the rule name for any report.

The “Apply this rule to” radio buttons are also disabled. You cannot change the Files, Duplicate
Files, or Directories rule types.

The remaining criteria to enter are the same as described previously to create a rule for
duplicate files.

4. Click Next. See "Add or Remove Volumes from a File Server Report Rule" below for more
information on how to remove and add volumes from a rule.

Add or Remove Volumes from a File Server Report Rule

Add or remove volumes from a file sever report rule:
To add volumes to a report rule:
1. Click the Show Filter link if the filter is not displayed.

2. Inthe Select OS field, select the operating system for the file server or select all to display all
file servers. The file servers meeting the criteria of the Select OS field are displayed in the
Select File Server window.

3. Inthe Select File Server window, select a file server. The name of the file serveris displayed in
the File Server Name field.

4. Click Go. HP Storage Essentials displays the volumes on the selected file server in the pane
below.

5. Select the volumes you want to add and click Add Selected Volumes to Report Rule. The
selected volumes are displayed in the Selected Volumes table.
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To remove volumes from a report rule:
1. Select the volumes in the Report Rule Volumes table.
2. Click Remove Selected Volumes from Report Rule.

3. Click Finish.

Enabling Rules

To enable the rules, use the screen displayed with the Report Rules tab.

Using Enable Rule feature, you can enable the rules which are currently in disabled state. On
enabling a rule the system gathers data, based on the conditions specified in the rule, for the
volumes to which the rule is mapped with.

Note: By default, all the rules created in the system are in enabled state.

To enable, select the rules and click Enable Rule(s) button.

Disabling Rules

To disable the rules, use the screen displayed with the Report Rules tab.

Using Disable Rule feature, you can disable the configured rules without deleting them from the
system. All the disabled rules are ignored during gathering of the data for the volumes they are
mapped with. Disabling rules also results in faster scanning of volumes, as the system does not
filter the data based on conditions specified in the rule.

To disable, select the rules and then click Disable Rule(s) button.

Deleting Rules

To delete rules, use the screen displayed with the Report Rules tab. The following is a
representative screen display.

Report Rules for File Servers:
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You can select the Delete button to delete multiple rules (those with checked boxes next to the rule
name), or you can delete individual rules using the Delete icon for the specific rule.

The result of removing (deleting) rules depends on whether or not the rule is mapped to a volume,
and whether data was collected for that rule.
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o If youremove arule that is not mapped to a volume, the rule is deleted directly.

o If youremove arule that is mapped to a volume AND the data is not collected, the system
deletes both the rule and the mapping data.

o If youremove arule that is mapped to a volume AND the data is collected, the system deletes
the rule, the mapped data, and also the collected data (report).

e When you select the Clear Now button, the system clears the data related to the rule.

Viewing Results in Report Tree

When the system gathers data for a volume, it checks to see if any rules are mapped to that
volume. If rules are mapped to that volume, the system collects the data according to the
parameters defined in the rule and stores this information in the data tables. The collected
information can then be viewed from the Reporter tree (Reporter > System > File Server).

Sometimes the File System Viewer report data might not be visible immediately after the rule
executes because the report's cache has not yet been updated. To refresh the File System Viewer-
related report cache data, select the Refresh FSRM Reports Cache Now button. The button is on
the Custom Reports tab screen, and is located next to the Add and Delete buttons in the upper
right part of the screen.

Enabling the Collection of Access Control
Entry Data Collection for Directories on
Windows Servers

Access Control Entries for directories can be collected on Windows file servers. You must enable
the collection of Access Control Entry Data to view information in the Trustee view.

To enable the collection of Access Control Entry Data:
1. Change the global property fileSrm.collectACL from false to true:
a. Click Configuration > Product Health.
b. Select Advanced from the Disk Space tree.

c. Changethevalueof fileSrm.collectACL from false to true by pasting the following in
the Custom Properties field:

fileSrm.collectACL=true
d. Click Save.

e. Restart the service for HP Storage Essentials, AppStorManager.
2. Select the Collect ACL option for a scan of a volume on a Windows server:
a. Click Configuration > File System Viewer.
b. Onthe File Server tab, select Windows in the Select OS Type menu and click Filter.

c. Click Add Schedule.
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d. Inthe top pane, select the storage volumes you want to add and click Add.

e. Inthe lower pane, select the Collect ACL option. You can select the option for specific
volumes or for all of the volumes at once. The following example shows the Collect ACL
option being selected for all of the volumes on a file server by selecting the option in the
heading.

Available Yolumes

Orive Type

Selected Yolumes

jEit_-:-ra!?_E F.”E_E;.'I'Ete ™ | Orive Type E conect M conect M map user Ta Exclude Directaries
olumne | Type A Eh Ownerinfo | Owner
= PO V) | 5 Local Disk m RECHCLER, snapshot ~s1
[ EE S E
3. Click OK.

4. Select Scan Now.

HP Storage Essentials starts gathering ACL data. To view the ACL data for all of your file servers,
access the Trustee view, as described in "Trustee View" on page 67.

When the collection option is enabled, the file scan process collects each directory’s Discretionary
ACL information, governed by the following considerations:

e The process collects only the information allowed by the access rules and ignores the
information denied by the access rules.

e The process considers allowing access based upon all the related rules, whether directly
assigned on the directory or whether they are inherited from one of the parent directories.

e The trustees corresponding to the Well Known SIDs as defined by Microsoft
(http://Support.microsoft.com/kb/243330) are excluded from being listed in the output.

e The effective permissions for each trustee are designated as Full Access, Write Access, or
Read Access.

= Write Access is the combination of the rights: List Directory, Traverse Directory, Add File,
Add Subdirectory, Write Directory, Traverse Directory, Read Attributes, and Read
Permissions.

= Read Access is a combination of rights: List Directory, Traverse Directory, Read Attributes,
and Read Permissions.

= Full Access is the combination of rights as defined by “Full Control by Windows.”
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Data Collection treatment is similar for both individual users and groups, that is, groups are not
drilled down to get a list of individual users.

The collection attempts to get the name of the various security entries from the corresponding
security ID (SID). The name resolution from the SID could fail if the SID is from a different host
or domain from the file server through which the file system is being scanned. In such cases, the
SID itself is listed as the trustee instead of the name.

The collected data is sent to afile on the disk along with other scan data files. The data file
created by the process is then transferred to the management server along with other scan files.
On the management server, the data is parsed to extract the effective usage by each trustee.

The process can have a performance impact during the scan. If the Access Control Lists are
extracted, the scan times can be larger than they would be otherwise.

About the FileSRMProvider.properties File

The FileSRMProvider.properties file resides in the conf directory of installed CIM Extensions. It
contains the following properties:

com.appiq.fsrm.dataDir — Defines the directory in which FSRM data and log files are written.
The default is the <CIM EXTN root>/xData directory. If there is an error with the directory
specified, the default directory is used. When you change the property, you must restart the CIM
extension for the new value to take effect.

com.appiq.fsrm.chunkSize — Defines the chunk size (in KB) used to transfer FSRM data to
the management server. Typically, it does not need modification by the user.

com.appiq.fsrm.StatusPollinterval — Defines how often (in seconds) the management server
retrieves the state of the current scan from the native FSRM process. The default interval is 60
seconds. Increasing the frequency of status polling (decreasing the polling interval) could
increase the length of time required by the scan.

Defining UNC Volumes

You can use UNC shares to discover file system data from a server. To scan UNC volumes, you
must define them in a UncShares.xml file.

To create the UncShares.xml file on a Windows host:

1.

2
3.
4

Confirm that a CIM extension is installed on the Windows host.
Go to the <Installation_Directory>\CimExtensions\conf directory.
Open the UncShares.xml-sample file in a text editor.

Identify the host through which the UNC shares’ scan is planned. This is the host through
which you will be scanning UNC shares from a different/remote host.

Add the host name and shared directory to the following line:

<!-- <UNC_SHARE PATH=""/> -->

Here is an example:

<UNC_SHARE PATH="\\RemoteSystem\MySharel"/>
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In this instance, RemoteSystem is the name of the host and MyShare is the name of the
shared directory.

Repeat for all your shares; for example:
<UNC_SHARE PATH="\\RemoteSystem\MySharel"/>
<UNC_SHARE PATH="\\RemoteSystem\MyShare2"/>

<UNC_SHARE PATH="\\RemoteSystem\MyShare3"/>

Save the file as UncShares.xml.
Restart the CIM Extension service on the managed host.

Update the element details for the host from the management server by running a Get Details.

© ® N o

Edit the File System Viewer configuration page for the host selecting the desired UNC shares
to scan.

The username and password combination you used for discovering the host should have at least

read only permissions on the file shares that need to be scanned. In most cases, this would be a

service account that you can have created in the active directory. This service account should be
an admin on the proxy FSV host and should have read only (at least) access to the UNC share.

You can use the IP address of the host instead of the name.

With management server versions earlier than 6.0, to discover multiple UNC shares that have
different credentials, you must use different proxy FSV hosts. This is because for these earlier
versions, you can use only use one login / password pair. Each UNC share has its own associated
login / password.

For management server version 6.0 and later, this restriction does not exist. You can specify
different credentials for each UNC Share or volume by using the Credentials option.

Known Issues

o Limitation of File Server Users in Policy Manager with Firefox. Firefox 3.5.3 (and likely other
versions of Firefox) will not load the Policy Manager tree if there is a large number of File Server
Users to be shown. Internet Explorer is able to load the Policy Manager tree under these
conditions.

¢ File Manager Exclude Directory might not Contain the Underscore. Scanning file detail
information fails if the custom property fileSrm.excludeDirectories is set to a value that contains
the underscore (“_") character.

o File System Viewer Event “Starting transfer of data file” is Not Sent. The “Starting transfer of
data file” event from File System Viewer usually seen in the Event Manager is not sent. You will
not be able to trigger a Policy using this event.

o Start File Manager Scan only after the Host Scan has Completed. It is possible to attempt to
start a File System scan before a scan of the host has been completed. The File System scan
will not run. Wait until the host has been completely scanned before attempting to start a File
System scan to gather file detail data.

o Directory Accessed/Modified Rules and Unix File Servers. An artifact of the Unix operating
system changes the Accessed and Modified dates for directories on Unix file servers when the
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directories are scanned by File System Viewer. Therefore, a File System Viewer Report Rule
that specifies either the directory Accessed or Modified date will appear not to function properly.
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Viewing File System Information Across
the Enterprise

Use File System Viewer to obtained detailed information about the file servers enterprise wide, a
specific file server or volumes.

File System Viewer displays information from file servers in views, which are accessible by

clicking File System Viewer ( Eﬁ )in the left pane and then setting a context, as described in
"Setting a Context" on the next page.

File servers and their hosts must be in the same organization for File System Viewer to work
properly.

This section consists of the following topics:

e "Setting a Context" on the next page

e "Saving a View" on the next page

e "Dashboard Information for the Enterprise" on page 48

o "Properties of the File Servers" on page 50

e "Extension View" on page 51

e "Providing Expressions for the Filter Fields" on page 51

e "Viewing Extension Groups" on page 52

e "Aging View for the Enterprise Context" on page 53

e "Sizes View for the Enterprise Context" on page 54

e "Managing Users on a File Server - Properties of Users" on page 55
e "Policies for a User" on page 63

o "Viewing Security and User Identifiers for All File Servers" on page 65
e "Trustee View" on page 67

e "Scan Status" on page 69

e "Scan Schedule" on page 70

o "Viewing Attribute Details" on page 70
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Setting a Context

If you do not see any file servers listed, verify that you have set up File System Viewer, as
described in "Setting up File System Viewer" on page 12.

Use the Set Context feature in File System Viewer to specify which elements you want File
System Viewer to scan.

To set a context for File System Viewer:
1. Select one of the following:

= Enterprise: All file servers or elements are included in the scan.

= File Server: All file servers, selected file servers or only one file server is selected in the
scan.

= Volume: All volumes, selected volumes or only one volume is selected in the scan.

If you selected:

= Enterprise, see step 2.

= File Server, follow these steps in order:
i. Select all or one of the operating systems from the Select OS Type menu.

ii. (Optional) Enter all or part of a file servers name in the Filter by File Server Name field.
Wild cards (*) are accepted. For example, if you want to scan all file servers that begin
with California, you would enter the following: California*

ii. Select file servers from the Select File Server field.
= Volume, follow these steps in order:
i. Select all or one of the operating systems from the Select OS Type menu.

ii. Enterall or part of a file servers name in the Filter by Volume Name field. Wild cards (*)
are accepted. For example, if you want to scan all volumes that begin with
Sacramento, you would enter the following: Sacramento*

iii. Select file servers from the Select Volume field.

2. Click Go. File System Viewer scans the specified elements and provides the information in the
lower half of the page.

To reset the context to Enterprise, click the Reset button.

3. Select the view you want.

Saving a View

File System Viewer enables you to save a view, so you can quickly access the information again
without selecting a context.
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For example, assume you have a volume that periodically fills up with data. You could save the
Sizes view for a volume so you can quickly access the view again to determine if the space is being
taken up by several very large files or many small files.

To save aview:

1. Select a context as described in "Setting a Context" on the previous page.
2. Selectaview.

3. Click Save View.

4. Provide a name for the view.

If you are saving the name of a view that includes information about a file server or volume, include
the name of the file server and/or volume as well as the name of the view.

File System Viewer saves the view in the My Views table:

Uzers_wiew_for_enterprize_context ﬂ

Filezervername_veolumename_explorer_view ﬂ |

Wait for the current page to complete loading before clicking a saved view in the My Views table;
otherwise, you might see an error when you click a saved view.

Dashboard Information for the Enterprise

The dashboard page of the management server provides an overview of the status of all file servers
in your network. The dashboard provides the following four panes.

As the file sizes grow, the units switch from megabytes to gigabytes.

Summary

o A graph displaying the top five file servers by scanned space
o Atable listing:

= Number of file servers

= Volumes

= Scanned space in megabytes
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= Users - The number of users
= Users space - The amount of space in megabytes being consumed

To see a full-page view, access the File Servers view for the Enterprise context, as described in
"Properties of the File Servers" on the next page.

Top ten extensions by size

Displays the top 10 file extensions that take up the most space in gigabytes. To see a full-page
view, access Extensions view for the Enterprise context, as described in "Extension View" on page
51.

Aging
Displays, in gigabytes, the size of files that have been modified or used within the following periods:

o 0-30days

e 30-60 days

e 60-90 days

e 90-180 days

o 180days-1year
e 1-2years

e 2-3years

o 3-4years

e 4-5years

e 5+ years

For example, if two 3-GB files were modified within the last 30 to 60 days, 6 GB would be displayed
for the 30-60 day label.

Sizing

Displays the number of files modified within the following period:
e 0-30days

e 30-60 days

e 60-90 days

e 90-180 days

e 180 days-1year

o 1-2years

e 2-3years
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o 3-4years

e 4-5years

e 5+ years

For example, if two 3-GB files were modified within the last 30 to 60 days, two would be displayed
for the 30-60 day label.

To access the dashboard:

3.
4.

Click File System Viewer ( ﬁ )in the left pane.

Select Enterprise from the Select Context menu. The Enterprise option tells File System
Viewer to scan for all file servers on the network.

Select Dashboard from the Select View menu.

Click Go. The four panes are displayed.

Torefresh data in a pane, click the Refresh button ( ) in the upper-left corner of the pane.

Properties of the File Servers

The File Servers view provides the same information as the Summary pane in the dashboard, in
addition to a table that lists all the file servers and their properties.

You can view the following information when you select the File Servers view for an Enterprise
context:

A graph displaying the top five file servers by scanned space

A table listing:

Number of file servers
Volumes

Scanned space in megabytes
Users (number of users)

Users space (amount of space being consumed)

A table displaying the following information for each of the file servers:

Volumes
Scanned space
Number of users

Amount of space

As the file sizes grow, the units switch from megabytes to gigabytes.

To access information about file servers:
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1. Click File System Viewer ( E\ )in the left pane.
2. Select Enterprise from the Select Context menu.

3. Select File Servers from the Select View menu.

Extension View

The Extensions view for the Enterprise context provides the following information for file
extensions:

o A graph displaying the top 10 file extensions by:
= Usage — Total size of all the files with the particular extension

= Count— Number of files with the particular extension

¢ A table displaying the following information for each file extension:

= Usage — Total size of all the files with the particular extension
= Count— Number of files with the particular extension

To filter the information for one or more file servers, provide the name of the file extension or provide
an expression in the Filter field and then click Submit. For more information about expressions, see
"Providing Expressions for the Filter Fields" below.

To view information about extension groups, select Extension Group from the Filter menu or provide
an expression. You must create extension groups before seeing any information, see "Viewing
Extension Groups" on the next page.

Dataless than 1 MB is not displayed in the charts. This could result in an empty chart if all data
points are less than 1 MB.

To access the Extension view for the Enterprise context:

1. Click File System Viewer ( E\ )in the left pane.
2. Select Enterprise from the Select Context menu.

3. Select Extensions from the Select View menu.

Providing Expressions for the Filter Fields

File System Viewer provides filter fields throughout the various windows. Use expressions such as
the wildcard (*) to narrow your view to a particular set of items.

All of the filters work the same. For example, even though the following examples are for file
extensions, the same expressions would work for any other item you want to filter, such as file
servers.

o d*returns all extensions starting with d

e *dreturns all extensions ending with d
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e *d* returns all extensions with d in the extension

Viewing Extension Groups

Create extension groups to determine how groups of file extensions are being used. For example, to
understand how much space graphic files are using and how often they are being used, you could
create a discovery group that contains file extensions for gif, png, and jpg graphic files.

After you create your extension groups, you can view the following information about them:
¢ A graph displaying the top 10 file extension groups by:
= Usage — Total size of all the files with the particular extension

= Count— Number of files with the particular extension

o A table displaying the following information for each extension group:

= Extensions — File extensions that make up the extension group
= Usage — Total size of all the files with the particular extension
= Count— Number of files with the particular extension

To display a reduced set of information, provide the name of the extension group or an expression in
the Filter field and then click Submit. For more information about providing expressions in the Filter
field, see "Providing Expressions for the Filter Fields" on the previous page.

Dataless than 1 MB is not displayed in the charts. This could result in an empty chart if all data
points are less than 1 MB.

Creating Extension Groups

To create an extension group:

Click File System Viewer ( ﬁ )in the left pane.
Select Enterprise from the Select Context menu.

Select Extensions from the Select View menu.
Select Extension Group from the Filter menu.

Click New Extension Group.

2 T A

Enter a name for the extension group in the Extension Group Name field; for example,
Graphic files.

7. Enterthe extensions toinclude in the group in the Extensions field. Separate each file
extension with a comma. For example, if you want the discovery group to track file extensions
for gif, png, and jpg files, enter the following in the Extensions field:

gif, png, and jpg
8. Click Finish.
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Editing Extension Groups

To edit a discovery group:

Click File System Viewer ( E\ ) in the left pane.
Select Enterprise from the Select Context menu.

Select Extensions from the Select View menu.

A w0 b=

Select Extension Group from the Filter menu.

5. Click Edit (Qé') for the extension group you want to edit.

6. Modify the extensions that should belong to the group in the Extensions field.

7. Click Finish.

Deleting Extension Groups

To delete an extension group:

Click File System Viewer ( E\ )in the left pane.
Select Enterprise from the Select Context menu.

Select Extensions from the Select View menu.

A w0 np =

Select Extension Group from the Filter menu.

5. Click Delete ( ﬁ) for the extension group you want to remove.

Aging View for the Enterprise Context

The Aging view provides the following information about the file servers in your environment:

e A graph displaying the size of files that were modified or used within the following time periods:
= 0-30 days
= 30-60 days
= 60-90 days
= 90-180 days
= 180 days-1year
= 1-2years
= 2-3years

= 34 years
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= 4-5years
= 5+ years

For example, if two 3-GB files were modified within the past 30 to 60 days, 6 GB is displayed for
the 30-60 day label.

¢ Atable displaying the number of files and their size that were accessed, modified, and created in
the specified time periods, which are the same as those listed in the graph. To view this table,
click the plus sign (+) to the left of the Show/Hide Aggregated Summary Details text.

o A table displaying, by file server, the number of files and their size in megabytes that were
created, modified, or accessed within the specified time period. To determine which type of
information to display in the table, select Accessed, Modified, or Created from the Age
Distribution menu, and then click Submit.

As the file sizes grow, the units switch from megabytes to gigabytes.

To access the Aging view:

1. Click File System Viewer ( ﬁ ) in the left pane.
2. Select Enterprise from the Select Context menu.

3. Select Aging from the Select View menu. The Aging view is displayed.

Sizes View for the Enterprise Context

The Sizes view can help you understand if space on a server is being taken up by a few very large
files that are never used.

The Sizes view displays the following information:
¢ A graph displaying the distribution of files by usage or by count within the following size groups:

= OBytes

= 0-10KB

= 10-100 KB
= 100 KB-1 MB
= 110MB

= 10-100 MB
= 100+ MB

o A table displaying by file server the number of files and their size that fall within the specified
size groups.

As the file sizes grow, the units switch from megabytes to gigabytes.

To access the Sizes view:
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1. Click File System Viewer ( ﬁ )in the left pane.
2. Select Enterprise from the Select Context menu.

3. Select Sizes from the Select View menu. The Size view appears.

To view additional information about the files within a size group, click one of the size groups in the
graph, as shown in the following example.

Size (GH)

100+ MB 10 --100 MB 10100 KB

Size Groups

The following are displayed:
¢ A pie chart showing the sizes of the files with the size group on each server.
e A pie chart showing the number of files with the size group on each server.

¢ A table showing the number of files with the size group on each server and the amount of space
they occupy.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all the data
points are less than 1 MB.

To view more information about the size group on a volume, click a file server in the File Server
column in the table.

The following are displayed:

¢ A pie chart showing the sizes of the files with the size group on each volume
¢ A pie chart showing the number of files with the size group on each volume

o A table showing the number of files with the size group on each volume, the amount of space
they occupy, and the collection time

Managing Users on a File Server - Properties
of Users

The Users tab enables you to see the properties of the user accounts assigned to file servers.

To access the properties:
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1. Click File System Viewer ( ﬁ )in the left pane.
2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the following methods:

e The management server scanning the file servers.

¢ Information imported through LDAP servers. For more information about importing users through
LDAP, see "Importing User Information from LDAP and Active Directory Servers" on page 27.

e Users created through the Create User tool in File System Viewer. For more information about
creating users in File System Viewer, see "Adding File System Viewer Users" on the next page.

The page displays the following:

¢ A graph showing the top five users by usage and the amount of space they use.

¢ A summary table to the right of the graph displaying the following:

Users — The number of users assigned to all of the file servers monitored.
Users Size — The amount of space the users use.
Largest User — The user who uses the most space.

Largest User Size — The amount of space the largest user uses.

o A table below the graph displaying the users and the following properties:

User ID — The ID of the user
User Name — The name of the user

Home Directory — The home directory of the user. The home directory is assigned to a user
by the user’s organization. By default, the user has full access rights (read, write, execute) to
the home directory. A user can have multiple home directories.

Owner — The owners who are associated with the user. A user can have multiple owners.

Department Number — The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

User Status* — The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

Manager® — The name of the user’'s manager.
Quota — The amount of space the user is allocated.
Used — The amount of space the user is using.

Instances — The number of file servers on which the user's home directory is present.

*The User Status and Manager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.
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To display the properties of just one user account or provide a wild car, enter the full name in the
Filter box, and then click Submit.

Viewing Details for a File System Viewer User

You can view detailed information about a File System Viewer user, such as the following:

Department

Quota

Total Used by Owners

Total Used by Directories

To view details of a File System Viewer user:

Click File System Viewer ( ﬁ\ )in the left pane.

1
2. Select Enterprise from the Select Context menu.
3. Select Users from the Select View menu.
4. Under the User ID column, click the link for the user you want to know more about.
You are shown detailed information about the user, such as the following:

o Which volumes and file servers the user is taking up space on and the amount

e Any policies assigned to the user

Adding File System Viewer Users

File System Viewer provides data about users on the file servers, including:

e The amount of space the users are using
e The userwho is using the most amount of space and the amount of space being used

It obtains information about its users from the file scans of the servers. You can also provide user
information through this tool.

This tool simulates the creation of a user account. To obtain information about users, you must first
add them in File System Viewer. These users differ from the users for the management server.
When you add a File System Viewer user, you are making File System Viewer aware of that user
for monitoring. That user is not granted access to the management server.

To add a File System Viewer user

Click File System Viewer ( E\ ) in the left pane.
Select Enterprise from the Select Context menu.

Select Users from the Select View menu.

A w0 D~

Click the New User button located under the graph.
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10.
1.

12.

In the ID box, enter the user ID.
In the Name box, enter the name for the user.

Provide the domain name for users on servers running Windows; for example,
mydomain\username. The domain name is case sensitive.

In the Directories box, specify a user's home directory. Home directories are assigned to users
by their organization. A user can have multiple, comma-separated home directories.

Directory paths are case sensitive and must be fully qualified paths. Map a user’s usage to the
home directory when configuring a file server scan.

In the Owners box, enter the owners that are associated with the user.

Separate multiple owners with a comma. The owner name should be similar to what the OS
reports; for example, the domain\username on Windows.

Information must be entered into either the Directories box or the Owners box. Entering
information into both boxes is accepted, but not required.

In the Department No menu, select a department number corresponding to the department to
which the user belongs. The department number was assigned to the department when the
department was added by using Chargeback Manager

In the E-mail box, enter the user's e-mail address.
In the Quota box, enter the maximum amount in megabytes the user can use.
Entering 0 in the Quota box grants unlimited storage capacity to the selected user.

Click OK.

Modifying File System Viewer Users

You can modify the following properties for a File System Viewer:

Name

Directories

Owners

Department Number
E-mail

Quota

The following procedure applies only to modifying a File System Viewer user, not a user account for
the management server:

1.

Click File System Viewer ( Ei )in the left pane.

2. Select Enterprise from the Select Context menu.

3. Select Users from the Select View menu.
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4. Inthe table below the graphic, click the Edit (D.f) button corresponding to the user you want to
modify.

5. Modify one or more of the properties.

6. Click OK. The File System Viewer user is updated.

Deleting File System Viewer Users

The following steps modify a File System Viewer user, not a user account for the management
server. They do not affect access to the management server or the file server.

To delete a File System Viewer user:

Click File System Viewer ( E\ )in the left pane.
Select Enterprise from the Select Context menu.

Select Users from the Select View menu.

A 0w D~

Do one of the following:

= Todelete one user at a time, click the Delete (ETI) button corresponding to the user you want
to remove. When you are asked if you want to delete the user, click OK.

= Todelete multiple users at once, select the users in the far left column and click the Delete
button located above the table. When you are asked if you want to delete the users, click
OK.

Exporting a List of Users

After you add your users, export the list of users in case you need to reinstall the management
server. The user list is saved as a comma-separated values file, which can be opened in a text
editor such as Notepad. You can add to the comma-separated list as described in "Modifying a List
of Users" below.

To export the list of users:

Click File System Viewer ( E\ )in the left pane.
Select Enterprise from the Select Context menu.

Select Users from the Select View menu.

Click Export Users.

o b~ w0 D=

When asked if you want to save the comma-separated values file, click Save and designate a
location to save the file.

Modifying a List of Users

After you export alist of users, you can easily add to it. The attributes for each user appear on a row
for that user. The format of a user’s record is as follows:

<User ID>,<User Name>,<Home Directory(s)>,<Department>,
<E- Mail>,<Quota><Owner (s)>
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Assume you have a user with the following attributes:

e UserID-JS

e User Name - John Smith

¢ Home Directory — Program Files

¢ Department — Engineering

o E-Mail — jsmith@companyname.com

e Quota-500

e Owner —jsmith

The information for the user would appear as follows in the list:

JS,John Smith, \Program
Files,Engineering, jsmith@companyname.com, 500, jsmith

A list with multiple users would appear as follows:

JS,John Smith, \Program
Files,Engineering, jsmith@companyname.com, 500, jsmith

JD, John Doe, \Program Files,Engineering, jdoe@companyname.com, 500, jdoe

DD, David Double, \Program
Files,Engineering, jdouble@companyname.com, 500, ddouble

The record for a user with multiple home directories would appear as follows:

JS, John
Smith, ”\jsmith, \home\jsmith”,Engineering, jsmith@companyname.com, 500

The record for a user with multiple owners would appear as follows:

Adm, Administrator,,,netadmin@mycompany.com, , “root,bin, adm, uucp, nobody,
Administrator”

The owner can be omitted if the home directory is provided, and the home directory can be omitted if
the owner is provided.

The following boxes must be valid. Failure of any of these conditions causes the management
server to log that record as an error and continue to the next record:

e <UserlID>
e <Home Directory> or <Owner>

e (Optional). <Department> — If you provide a department, the department must exist on the
management server. The department can be empty.

e (Optional). <Quota>

e Optional: <E-Mail>
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Restrictions for User Boxes

Box Condition

UserID Required box. Cannot include the following:

o More than 64 characters
e Single quote (')

e Double quote ()

e Forward slash (/)

e Back slash (\)

User Name | Required box. Cannot include more than 64 characters.

Home Required if the owner is not specified.
Directory

List of one or more directories separated by commas, with each directory name
not more than 4000 characters.

Individual directory names should not contain commas.

Department | Null or an existing department.

E-Mail Null or a string of up to 253 characters.

Quota Null or 0 to indicate unlimited, or a rational decimal number less than
(Megabytes) | 9999999999999.

Value is in MBs.

Owner Required if the home directory is not specified.

List of one or more owner names separated by commas, with each individual
owner name not exceeding 256 characters.

Individual owner names should not contain commas.

Viewing Detailed Information for a User

To view the amount of space being used on a volume and other information for a user:

5.

. Click File System Viewer ( ﬁ )in the left pane.

. Select Enterprise from the Select Context menu.

1

2
3.
4

Select Users from the Select View menu.

. Click aUser ID in the User ID column.

Click the Owners tab.

The following information is displayed for the user:
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File server name

Volume name

Size used

Owner

Importing a List of Users

You can import alist of users from a comma-separated values file. For information on how to add to
the current list of users in File SRM, see "Exporting a List of Users" on page 59 and "Modifying a
List of Users" on page 59.

The management server provides two ways to import a list of users:

o Full Import — Replaces all current users in the list with the users in the import file
o Partial Import — Updates existing users and adds new users

Toimport a list of users:

Click File System Viewer ( ﬁ\ ) in the left pane.
Select Enterprise from the Select Context menu.

Select Users from the Select View menu.

Click Import Users.

Click Browse to select the list of users you want import.
Select Full Import or Partial Import.

Click OK.

N o a > w0 Dd =

When you perform a partial or full import, you are provided with a report with the following
information:

o Number of records read

¢ Number of users created

e Number of users updated

o Number of users that could not be created
o Format errors

o Directory and owner both unspecified

e Directory already mapped to a user

e Owner already mapped to a user
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¢ Invalid departments

o Multiple entries for users

Policies for a User

To view the policies for a user:

1

2
3.
4
5

Click File System Viewer ( Ei )in the left pane.

Select Enterprise from the Select Context menu.
Select Users from the Select View menu.
Click aUser ID in the User ID column.

Click the Policies tab. File System Viewer displays the policies assigned to the user.

Policy Manager can automatically send an e-mail, generate an event, or run a custom script when
the file server is being overused. For example, you can configure Policy Manager so you receive an
email message when the amount of free space on afile server decreases to a specified level.

Adding Policies

To add the policies for a user:

10.
1.

© ® N o 0o > w0 N~

Click File System Viewer ( ﬁ )in the left pane.

Select Enterprise from the Select Context menu.

Select Users from the Select View menu.

Click aUser ID in the User ID column.

Click the Policies tab.

Click Add in the right corner.

In the Name box on the Policy Properties tab, enter a name for the policy or keep the default.
In the Description box, modify the description for the policy or keep the default.

In the Re-arm Period box, specify the amount of time (in minutes) after the policy executes
before it can execute again. The re-arm period is useful for limiting the number of times the
same actions execute. You can specify shorter periods forimportant applications.

In the Condition menu, specify a comparison operator.

To the right of the Comparison Operator menu, take the following action, depending on the box
displayed:

= Entera percentage.

= Enter an amount in gigabytes (GB).

= Type the number of available media that will trigger an alert.
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12. Fortrending policies, enter the number of days in the Historic period box (7 to 180 days) and
Projection period box (min=1; max=180). The Historic period is the number of days in the past
that meet the condition.

13. Fortrending policies, enter the number of days in the future that will meet the condition in the
Projection period box (1 day to 360 days).

14. Select an action to occur when the policy condition is fulfilled. For more information, see
“Actions Available for When a Policy Condition is Fulfilled” in the User Guide.

15. Click Finish.

For more detailed information, see the Managing Policies chapter in the User Guide.

Editing Policies

To edit a policy:

Click File System Viewer ( ﬁ ) in the left pane.
Select Enterprisefrom the Select Context menu.

Select Usersfrom the Select View menu.

Click aUser IDin the User ID column.

o b~ w0 D=

Click the Policies tab.

Click the Edit (E’f) button corresponding to the policy you want to modify.

In the Name box, change the name for the policy.

In the Description box, change the description for the policy.

© ®©® N o

Select or deselect the Active option to activate or de-activate the policy.

10. Inthe Re-arm Period box, specify the amount of time (in minutes) after the policy executes
before it can execute again. The re-arm period is useful for limiting the number of times the
same actions will execute. You can specify shorter periods for important applications.

11. Inthe Condition menu, change the conditions of the policy.

12. Fortrending policies, change the number of days in the Historic period box (min=7; max=180)
or Projection period box (min=1; max=180).

13. Select an action to occur when the policy condition is fulfilled. For more information, see
“Actions Available When a Policy Condition is Fulfilled” in the User Guide.

14. Click OK.

Testing Policies

To test a policy:

1. Click File System Viewer ( ﬁ )in the left pane.
2. Select Enterprise from the Select Context menu.
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Select Users from the Select View menu.

3
4. Click aUser ID inthe User ID column.
5. Click the Policies tab.

6

Click the Test button for the policy.

Deleting Policies

To delete a policy:

Click File System Viewer ( ﬁ )in the left pane.

Select Enterprise from the Select Context menu.
Select Users from the Select View menu.
Click aUser ID in the User ID column.

Click the Policies tab.

o o~ w D =

Do one of the following:

= Delete just one policy — Click the Delete (ﬁ) button corresponding to the policy you want
to delete.

= Delete several policies at once — Select the check boxes next to the policies you want to
delete. To select all of the policies, select the check box next to the Name heading, and

click the Delete (1) button.

The policies are deleted.

Viewing Security and User Identifiers for All
File Servers

The Ownership tab displays owner-related details. It enables you to determine how many files the
owner is using on the file server.

The Ownership tab is disabled by default for file servers running on Microsoft Windows. To view the
Ownership tab, set the fileSrm.collectWindowsSID property to true as described in "Enabling the
Ownership Tab on Windows" on the next page. You can also view it by selecting the Collect
Ownership Information checkbox when configuring a file server scan.

To access the Ownership tab:

Click File System Viewer ( ﬁ\ )in the left pane.

2. Select Enterprise from the Select Context menu.
3. Select Ownership from the Select View menu.

You will see the following:
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= A graph showing the top 10 owners that use the most in megabytes

= Atable that lists:
© Ownership — The security identifier (Windows) or user identifier (UNIX)
o Files — The files the security identifier or user identifier uses

o Size - The total size of the files the security identifier or user identifier uses

4. Tofilter by owner or by expression, enter the information in the Filter field, and click Submit.

For more information, see "Providing Expressions for the Filter Fields" on page 51.

Viewing Detailed Information About an Owner

To view detailed information:

1
2.
3

4.

Click File System Viewer ( E\ )in the left pane.
Select Enterprise from the Select Context menu.

Select Ownership from the Select View menu.

To learn more about an owner, click the owner’'s name.

The following are displayed:

¢ A pie chart showing the sizes of the files with the owner on each server

¢ A pie chart showing the number of files with the owner on each server

¢ A table showing the number of files with the owner on each server and the amount of space they

occupy

Dataless than 1 MB is not displayed in the graphs. This could result in an empty graph if all the data
points are less than 1 MB.

Enabling the Ownership Tab on Windows

The Ownership tab is disabled by default for file servers running on Microsoft Windows. To view the
Ownership tab, you must set the fileSrm.collectWindowsSID property to true.

Tosetthe fileSrm.collectWindowsSID property to true:

1.
2.
3.

Select Configuration > Product Health and click Advanced in the Disk Space tree.
Click Show Default Properties at the bottom of the page.
Copy the fileSrm.collectWindowsSID property.

How you copy the text depends on your Web browser. If you are using Microsoft Explorer or
Netscape Navigator, select the text, right-click the selected text, and select Copy.

Return to the Advanced page (Configuration > Product Health and click Advanced in the
Disk Space tree).
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5. Paste the copied text into the Custom Properties box.
How you paste the text depends on your Web browser. If you are using Microsoft Explorer or
Netscape Navigator, right-click the box, and select Paste.

6. Make your changes in the Custom Properties box.

7. Change the value assigned to the fileSrm.collectWindowsSID property to true.
fileSrm.collectWindowsSID=true

8. When done, click Save.

9. Restart the AppStorManager service for your changes to take effect.

Trustee View

If you do not see information in the Trustee View, check that ACL data collection is enabled (see
"Enabling the Collection of Access Control Entry Data Collection for Directories on Windows
Servers" on page 40).

The Trustee view provides the following:

o A graph listing the top 10 trustees by size

o Atable listing the following for each trustee:
= Size
= Directories

To access the Trustee view:

Click File System Viewer ( E\ )in the left pane.
Select Enterprise from the Select Context menu.

Select Trustee from the Select View menu.
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To filter the information for one or more trustees, provide the name of the trustee or provide an
expression in the Filter field and then click Submit.

For more information about expressions, see "Providing Expressions for the Filter Fields" on page
51.

Viewing Detailed Trustee Data

To view detailed information for a trustee, click the name of a trustee in the Trustee view. You are
then shown two pie charts:

e Size associated with the trustee in megabytes
e Number of directories associated with the trustees

Below the pie charts is a table listing the size in megabytes and directories for each file server
associated with the trustee. The following is an example:
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All File Servers
Owner fsrm140wser2

Size (MB) No. Of Directories

® FSRM140 = 3,741,246 ® FSRM140 = 29,428

File Server

Directories

FSRM140 3,741,246 MB 29428

Here is an example of Selected Trustee Drill-down at the file server level:

o
| File Server FSRM140
Owner fsrm140wser2
Size (MB) No. Of Directories
®C:=3744,246 ® C:=29,428
e | orectores  foomean |
(= 374 245 MB 29,428 2007-03-12 14:06 ]

To obtain even more detailed information about the directories associated with the trustee, click one
of the pie charts or afile server listed in the table.

A table is provided with the following information for each directory associated with the trustee:

o Size of the current directory in megabytes
e Size of the current directory including subdirectories
o Number of trustees

e Trustee’s share

o Attributes — See "Viewing Attribute Details" on page 70 for more information about the meaning
behind the letters.

e Permissions — The letters in the Permissions column have the following meaning:
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= R-Read
= W -Write

= F—Full

How Data is Calculated in the Trustee View

On the management server, the data is parsed to extract the effective usage by each trustee. This
is calculated by the summation of effective usage by the trustee on each directory has permission
to access. The following shows how the effective space calculations are determined for the
statistics shown in the example.

Directory Statistics

Directory Name Full Size Own Size Trustee Rights

A 10GB 8GB X F
Y R
7z —

B 18 GB 12GB X -
Y F
z W

C 14 GB 6 GB X F
Y F
z F

The following is the effective space calculation:

e X:From A + From B + From C = (8/2) + 0 + (6/3) = 6GB
e Y:FromA +FromB + FromC = (8/2)+ (12/2) + (6/3) =12GB
e X: From A + From B + From C = 0 + (12/2) + (6/3) = 8GB

The “own” size of a directory is considered for calculation and not the full size (which includes the
size of its subdirectories), because the subdirectories are being calculated separately anyway.

User interface screens are available to display the ACL information at various levels, including the
Enterprise level (all file servers), a selected file server, and a Volume level, for all the trustees. In
addition, drill-down is available for selected trustees at various levels.

Scan Status

The Scan Status view displays detailed information from the scans. This information is also
available from the Scan Status tab, which you can access by selecting Configuration > File
System Viewer. For detailed information about scan status information, see "Scan Status Tab" on
page 25.
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Scan Schedule

The Scan Schedule view displays the scheduled scans. This information is also displayed in the
Scheduled Scan tab accessible from the Configuration > File System Viewer menu. For more
detailed information about scan schedules, see "Scheduling Single and Multiple Scans" on page 15.

Viewing Attribute Details

In several of the views, attribute information is provided as a letter or several letters in the Attribute

column. The attributes have the following meaning.

Letter Detail

Read Only

Hidden

System

Directory

Archive

Device

Normal

Temporary

v || Z2(<|>»|O0O|0|IT|=>

Sparse File

[

Reparse Point

Compressed

ol O

Offline

Not Content Indexed

Encrypted
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Individual File Server Details

This section consists of the following topics:

"Dashboard Information for a File Server" below
"Properties for a File Server" on page 74

"Finding Volume Details" on page 75

"Type of Files on a File Server" on page 76

"Aging Properties of Files on a File Server" on page 79
"Size Group Distribution Information" on page 80
"Users for a File Server" on page 81

"Ownership Information for a File Server" on page 82
"Trustee Information for a File Server" on page 82
"Events for a File Server" on page 83

"Viewing Topology for a File Server" on page 91
"Scan Status for File Servers" on page 91

"Scan Schedule for File Servers" on page 92

Dashboard Information for a File Server

The dashboard displays the following information for file servers.

Summary

¢ A graph displays the top five volumes by usage on the file server. The amounts for free space
and used space are shown. Data less than 1 MB is not displayed in the graph. This could result

in an empty graph if all data points are less than 1 MB.

e A summary table to the right of the graph shows:

= Volumes — Number of volumes on the file server

Capacity — Size of all volumes on the file server

Used — Amount of used space on all volumes on the file server

Free — Amount of free space on all volumes on the file server
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Used Percent — Amount of used space on all volumes on the file server

Free Percent — Amount of free space on all volumes on the file server

Users — Number of users assigned to one or more of the volumes on the file server

Users Space — Amount of space the users use on the file server.

o Top ten extensions by size displays the top 10 file extensions that take up the most space in
gigabytes.

e Aging displays the (gigabyte) size of files modified or used within the following periods:

0-30 days

= 30-60 days

= 60-90 days

= 90-180 days

= 180 days-1year
= 1-2years

= 2-3years

= 3-4years

s 4-5years

5+ years

For example, if two 3-GB files were modified within the past 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

e Sizing displays the number of files modified within the following period:

0-30 days

30-60 days

= 60-90 days

= 90-180 days

= 180 days-1 year
= 1-2years

= 2-3years

= 3-4years

= 4-5years

= 5+ years
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For example, if two 3-GB files were modified within the past 30 to 60 days, two would be
displayed for the 30-60 day label.

To access the dashboard:

1

2
3.
4

Click File System Viewer ( ﬁ\ ) in the left pane.
Select afile server, as described in "Setting a Context" on page 47.

Select Dashboard from the Select View menu.

Click Go.

To refresh data in a pane, click the Refresh button ( ) in the upper-left corner of the pane.

Properties for a File Server

To view the properties for afile server:

1.
2.

3.

Click File System Viewer ( ﬁ )in the left pane.
Select afile server, as described in "Setting a Context" on page 47.

Select Properties from the Select View menu.

The Properties page displays the following information

Business Cost — The cost impact of the application on the network. The currency displayed
depends on the standards and formats setting on the management server. In the Business Cost
field, type an amount; for example, 35.25, and then click OK.

Custom Name — A unique name for the file server. The custom name is displayed for the File
System Viewer application instead of the file server's default name. The unique name helps in
distinguishing this File System Viewer instance from the actual server. To create a unique
name, type the name in the Custom Name field and click the Save button.

Vendor* — The vendor that created the file server

= The only symbol you can enter in front of the number is the dollar sign ($).
= You can enter a number with decimal points, such as 30.50.

Contacted” — The last time the software contacted the file server

Record Created* —\When a record was created for the file server

Discovery Status* — The status of the last discovery. If the element was just discovered, the
status is at “created.”

Install Date — When the file server was installed
Name Detected” — The name of the file server detected

OID — The Object Identifier
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o Description* — Information about the type of element. In this instance, it would display
FileServer.

e Target Operating System* — The operating system of the file server

« ldentificationCode — The identification code of the file server

¢ Product Name* — The product name of the file server

¢ Serial Number — The serial number of the file server

e Build Number — The build number of the file sever

¢ Version — The version number of the file server

¢ Host" — The name of the host

o Business Cost (per hour) — The business cost that was set at the top of this page

*Populated fields. By default, the rest are blank.

To update the data by doing a Get Details, click Update Element Data. Get Details could take a
while.

Finding Volume Details

To view the properties of the volumes on a file server:

1. Click File System Viewer ( ﬁ ) in the left pane.
2. Select afile server (see "Setting a Context" on page 47).

3. Select Volumes from the Select View menu.
You can view additional information on volumes that have had file server collection.
This page displays the following:

e A graph that shows the top five volumes by usage on the file server, including the amounts for
free space and used space.

Dataless than 1 MB is not displayed in the graph. You might see an empty graph if all data
points are less than 1 MB.

e A summary table to the right of the graph that shows:

= Volumes — The number of volumes on the file server

= Capacity — The size of all volumes on the file server

= Used — The amount of used space on all volumes on the file server
= Free — The amount of free space on all volumes on the file server

= Used Percent — The amount of used space on all volumes on the file server
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= Free Percent — The amount of free space on all volumes on the file server
= Users — The number of users assigned to one or more of the volumes on the file server
= Users Space — The amount of space the users use on the file server

o A table below the graph that shows the volumes and the following properties:

= Capacity — The size of the volume

= Used — The amount of space used on that volume

= Used% — The percentage used on the volume

= Users — The number of users assigned to that volume

= Users Space — The amount of space the users use

Type of Files on a File Server

The Extensions view provides information about the types of files on a file server. For example, it
can let you know how many mpgs are stored on a file server and their file size. In the extensions
tab, there is a drop-down menu to select Extension Groups, in which files are grouped by file type.

To view information about file extensions on a server:

1. Click File System Viewer ( ﬁ\ ) in the left pane.
2. Select afile server (see "Setting a Context" on page 47.

3. Select Extensions from the Select View menu. The following are displayed:

= A graph that shows the top 10 extensions and their size

= A table below the graph that shows the extension and its properties:
Size — The size of all the files with that extension. This property lets you see which types of
files are using the most space on afile server.

Count — The number of files with this extension.

4. Tofilter by extension, enter the extension name and click the Submit button (see "Providing
Expressions for the Filter Fields" on page 51).

5. Click an extension in the Extension column in the table. You can see the following:

= A pie chart that shows the sizes of the files with the extension per volume.
= A pie chart that shows the number of files with the extension per volume.

= Atable that lists the number of files with the extension per volume and the amount of space
they occupy.

Dataless than 1 MB is not displayed in the graph. This could result in an empty graph if all data
points are less than 1 MB.
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6. Toview allisting of the files with the extension on the volume, click a volume in the Volume
column in the table. The largest N and most aged N files with the extension are listed in the
tabs “Largest Files” and “Aged Files.” The filename with path, size, and the accessed,

modified, and created time are provided.

7. You can save the extensions for a volume in a comma-separated list by clicking the Save
Extension Detail button in the right pane. The extensions for that volume are saved in a

comma-separated list (CSV file).

Excel can only handle a limited number of records. If the file will not open in Excel, it may be
necessary to bring the CSV file into a database. Another option is to break the CSV file into smaller

pieces that Excel will be able to handle.

Extension Groups

The following example shows the Extensions tab selected and the drop-down menu choices for

selecting Extension Groups.

File Sarver FSRM140
Host FSRM140
Top 10 Extensions by Size
1600 {
14800 |
1200 1
@ 1000 |
=
= 8001
B
000 {
o0 |
=] EE
o B N S s
" e Amp Al jar wie 1 dat eab il
Extensions
[Exensions __Te] Filter ;| BN
Exferetn Grous [ s [ e JE
1,575 W8 551
=] 1519 W8 0
dmp 1,036 MB 4
dl &19MB 4,153
Jor 3amB 805

Select Extension Groups to display a screen showing the extension groups along with the

extensions. A screen similar to the following displays.
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servers JI SN ning | sives | users | sconstatus ] Scan Scheduie

Top 10 Extensions by Size
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800 1
@
":" il
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EXE_F... Archiv... Image_... docFiles Souice... Muktim...
Extensions

[Eaersmcroms =] Fiter:| " Suomit | ew tension rove
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|EH.E FILES exe, dil, 50, bat 1149M8 5751

| Archive_Fies zip, tar, war, jar 539 MB 243 @ o

| image_Files jpe, joeg, gif, bmp 2mMe 356 F 0@

| docFiles o, doc, rif, xsl 12 MB | B |
| Source_Files java, cpp, gl 4 MB 508 [ o |
| Mutimecia_Fies wav, mp3, mpeg, mpg, avi 3MB s B¢ 0@ |

You can edit or delete extension groups using the Edit or Delete icons. To create a new extension
group, select the New Extension Group button, and a screen similar to the following is displayed.

3 http:/ /mansoorad - Create ExEen:

Extenszion Mame:* I

Extensions:* I

T T

|Duna

You can enter the new extension group name and the extensions separated by commas. After
extension groups are created, extension group detail information appears in the Extensions tab
when the extension group is selected from the drop-down menu.
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From the volume level extension groups chart page, you can go to an intermediate page before a
final drill-down page. The intermediate page lists constituent extensions with hyperlinks to the drill-
down page to that specific extension. Here is an example.

File Server FSRM140
Volume C: as of 2007-01-04 18:13
Extension zip, tar, war, jar

| Extension | se | cCom |
jar 19 MB 805
zip 517 MB 138

| ar <M 3]

The display lists constituent extensions with hyperlinks to the drill-down page for that specific
extension.

Filtering Files

Filters use the following expressions:

e d*returns all extensions starting with d
¢ *dreturns all extensions ending with d
e *d* returns all extensions having d in the extension

You can enter a list of extensions separated by a comma.

Aging Properties of Files on a File Server

To find information about the aging properties of the files on a file server:

1. Click File System Viewer ( ﬁ )in the left pane.
2. Select afile server, as described in "Setting a Context" on page 47.
3. Select the Aging view in the right pane.

Save the aging details to a comma-separated list (CSV file).

By default the page displays the following information:

e A graph displaying in gigabytes the size of files that have been modified or used within the
following time periods:

= 0-30 days
= 30-60 days

= 60-90 days
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= 90-180 days

= 180 days-1 year
= 1-2years

= 2-3years

= 3-4years

= 4-5years

= 5+ years

For example, if two 3-GB files were modified within the last 30 to 60 days, 6 GB is displayed for
the 30-60 day label.

o Atable displaying the number of files (and their size in megabytes) that were accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph. To view this table, click the plus sign (+) to the left of the Show/Hide Aggregated
Summary Details text.

o Atable displaying, by volume, the number of files (and their size in megabytes) that were
created, modified, or accessed within the specified time period. To determine which type of
information to display in the table, select Accessed, Modified, or Created from the Age
Distribution since last menu, and then click Submit.

Size Group Distribution Information

To view size information for a file server:

1. Click File System Viewer ( ﬁ\ ) in the left pane.
2. Select afile server, as described in "Setting a Context" on page 47.

3. Select the Sizes view.
The page displays the following:

= A bar chart displaying the size group distribution by usage or by count depending on the
option selected.

© Usage: Total size of all the files with the particular extension.
o Count: Number of files with the particular extension.
= A table listing the number of files and the total size for each size group on each volume.

4. To obtain more detailed information about a size group, click its corresponding heading in the
table. The following are displayed:

= A pie chart showing the sizes of the files with the size group per server.

= A pie chart showing the number of files with the size group per server.
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= A table showing the number of files with the size group per server and the amount of space
they occupy.

Data less than 1 MB is not displayed in the graphs. This could result in an empty graph if all the
data points are less than 1 MB.

5. Toview allisting of the oldest files with the size group on the volume, click a volume in the
Drive column in the table.

You can save the files with the size group for a volume in a comma-separated list (CSV file) by
clicking Export Files to CVS.

Users for a File Server

To view user information for a file server:

1. Click File System Viewer ( Ei )in the left pane.

2. Select afile server, as described in "Setting a Context" on page 47.
3. Select Users from the Select View menu.
The user account names displayed on this page are obtained by the following methods:

e The management server scanning the file servers.

¢ Information imported through LDAP servers (see "Importing User Information from LDAP and
Active Directory Servers" on page 27).

e Users created through the Create User tool in File System Viewer (see "Adding File System
Viewer Users" on page 57).

The page displays the following:
e A graph showing the top five users by usage and the amount of space they use
¢ A summary table to the right of the graph displaying the following:

= Users — The number of users assigned to all of the file servers monitored

Users Size — The amount of space the users use

Largest User — The user who uses the most space

Largest User Size — The amount of space the largest user uses

e A table below the graph displaying the users and the following properties:

n User ID —The ID of the user
= User Name — The name of the user

= Home Directory — The home directory of the user. The home directory is assigned to a user
by the user’s organization. By default, the user has full access rights (read, write, execute) to
the home directory. A user can have multiple home directories.

= Owner — The owners who are associated with the user. A user can have multiple owners.
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= Department Number — The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

= User Status* — The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

= Manager* — The name of the user's manager

= Quota — The amount of space the user is allocated

= Used — The amount of space the user is using

= Instances — The number of file servers on which the user's home directory is present

*The User Status and Manager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild card, enter the full name in the
Filter box, and then click Submit (see "Providing Expressions for the Filter Fields" on page 51).

Ownership Information for a File Server

To view ownership information for a file server:

1. Click File System Viewer ( Ei\ )in the left pane.

2. Select afile server, as described in "Setting a Context" on page 47.
3. Select Ownership from the Select View menu. The following are displayed for the file server:
= A graph showing the top 10 owners who use the most in megabytes (MB)
= Atable showing:
© Ownership — The security identifier (Windows) or user identifier (UNIX)
o Size - The total size of the files the security identifier or user identifier uses

o Files —The files that the security identifier or user identifier uses

4. Tofilter by owner or by expression, enter the information in the Filter field, and click Submit.

For more information about filtering by expressions, see "Providing Expressions for the Filter
Fields" on page 51.

Trustee Information for a File Server

If you do not see information in the Trustee View, check that the ACL data collection was enabled
(see "Enabling the Collection of Access Control Entry Data Collection for Directories on Windows
Servers" on page 40).

The Trustee view provides the following:

o A graph listing the top 10 trustees by size

¢ Atable listing the following for each trustee:
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= Size
= Directories

To access the Trustee view:

1. Click File System Viewer ( E\ )in the left pane.
2. Select afile server, as described in "Setting a Context" on page 47.

3. Select Trustee from the Select View menu.

To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
"Providing Expressions for the Filter Fields" on page 51.

For information about how the trustee data is collected, see "How Data is Calculated in the Trustee
View" on page 69.

Events for a File Server

The Events view lists the events that involve the file server. It provides the following information
about the events for a file server.

To access the Events tab:

1. Click File System Viewer ( ﬁ )in the left pane.

2. Select afile server, as described in "Setting a Context" on page 47.

3. Select the Events view in the right pane.

Events listed on this page might not be attributed to the correct source until Getting Details
completes.

Setting up a Filter

The management server provides several types of event filters that enable you to specify the
events you want Event Manager to display.

You can use all of the following event filters at once or just one of them:

e Time period
o Severity level
e Element type
e Summary text
o Element name
o Cleared status

e Specific element
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To set up afilter:

1. Click the Filter heading at the top of the page:

Event Manager

+ Summary

| Do elct

The following filtering feature is displayed:

- Fiker

Severties Element Types
; _— s . Cleared
= Summary Text Contains )
B
%3‘2’““"‘9 Tie Period Unknaown Al _ [Css |
Peric .
7| Informational Calapse al events with same .
] Contai ) = Aulornalicaly fiker
0 Last one day ¥ lvwami 9 Element Name Contains severfty, type and element O c:cry' iy i
Iinor 1
| Major ~|| [Tape Library -
= Advanced Options

2. Select atime from the Time Period combo box. You can also select a customized time as
described in "Selecting a Custom Time Period" on page 86.

Time Period

Last one day  #

Last two days
Last one week
fLast two weeks
Last one month

3. Select which events of a severity type you want displayed. Use the Control and Shift keys to
select multiple severities. The following options are provided:
= All - Events of all severities are displayed.
= Unknown — Only events of the severity type, unknown, are displayed.
= Informational — Only events of the severity type, informational, are displayed.
= Warning — Only events of the severity type, warning, are displayed.
= Minor — Only events of the severity type, minor, are displayed.
= Major — Only events of the severity type, major, are displayed.

= Critical — Only events of the severity type, critical, are displayed.

4. Select which events of an element type you want displayed. Use the Control and Shift keys to
select multiple severities. The following options are provided:
= All

= Application
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10.

= Host

= Switch

= Storage System
= Tape Library

= Fabric

= Other

= HP Storage Essentials

To set the filter by summary text, enter the text for the filter in the Summary Text Contains
field.

You can use this option when you are seeing several events that span over several elements or
severity levels. For example, to determine if someone else is logging into the management
server as admin, you can find how often the admin user has logged into the management
server over the last few days by entering the following text in the Summary Text Contains
field:

User admin logged in

To set the filter by element name enter text in the Element Name Contains field.

This feature can be helpful if you are interested in events from elements that have similar
names. For example, assume you have a naming convention for hosts, where all hosts that
belong to the engineering group begin with engineering. Event Managercan display only events
from those hosts when engineering is entered in the Element Name Contains field.

To set afilter by cleared status, select one or more of the following by using the Control and
Shift keys:
= All —All events regardless of their clear status

= All But Clear — All events except for those marked clear
= Clear — Only events marked clear

To merge all events together, select Collapse all events with same severity, type and
element.

This feature is very useful when numerous events of the same severity, type, and element are
being picked up by the management server. If you select the option Collapse all events with
same severity, type and element, the management server displays just unique events with a
total count in front of them, rather than list all of the events individually.

To have Event Manager filter elements automatically at a set interval, select the
Automatically filter every option and select one of the following:
= 30 seconds

= 1 minute
= 5 minutes
= 10 minutes

When done setting your options, click the Filter button.

You can update the events displayed by clicking the Filter button.
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Selecting a Custom Time Period

You can select a custom time period for the filter when troubleshooting an issue.
To select a custom time period:

1. Select the Custom Time Period option.

Custom Time
Period

T

Event Manager only displays events that occur after the start date and time and before the end
date and time.

2. Click the Calendar icon to the right of the Start Date field:

Start Date Severities

I~
|2007-07-25 05:01 |% ~

Informational

Minnr
End Date |Click here to change date|
e
2007-07-2605:01  |[@) |VWamning
Critical v

3. Inthe Calendar, select the start date:

A Select Date - Mi... [= |[E][X]

Q w2007

THERERERE
8|9 |10f1|12|13 12
15|16 |17 |18{19|20 |21
22 (23|24 |25( 26|27 (28
20(30(31|1(2[3[4

05:01 | |Set]

4. Inthe Time field, enter the start time.

The time is based on a 24-hour clock. For example, to have Event Manager display events
occurring after 8 p.m. on the specified date, enter 20:00.

5. When you are done setting the start time and date, click Set.
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You can set the end date and time for the filter. Event Manager only displays events that occur after
the start date and time and before the end date and time.

1. Click the Calendar icon to the right of the End Date field.

2. Inthe Calendar, select the end date:

3 Select Date - Mi...

=1

Q 2007 @

1|23 (45|67
8|9 |10(1|12|1314
15|16 |17 18(19(20 (21
22 |23 |24 (25|26 | 27 |28
20(30(31|1[2[3[4

05-01 | |Set]

3. Inthe Time field, enter the end time.

The time is based on a 24-hour clock. For example, to have Event Manager display events
occurring before 8 p.m on the specified date, enter 20:00.

4. When done setting the end time and date, click Set.

Resetting a Filter

To revert to the default settings for the filter:

1. Toaccess the filter for Event Manager, click the Filter heading at the top of the page:

Event Manager

+ Summary

| Doc sl

The filtering feature is displayed:

Severties Element Types
) R Clearea
— L ALL L
- " w
23:1“"““’9 S T— Unknawn Application LB m EESERY
Peri e B ;
ost Calapss al evenls wilh same ]
| ; Autoenaticaly fiber

0 Lastoneday ¥ |ywaming Switch Element Name Cortains . ermy. tyge and element O wen: h‘

Ilinar Storage System ]

Major ~|| [Tape Library bl -
+ Advancad Ogtions

2. Click the Reset button. The filter is reset.
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Setting up Advanced Filtering

Event Manager provides an advanced filtering feature that enables you to determine detailed

information for filtering.

To set up advanced filtering:

1. Toaccess the filter for Event Manager, click the Filter heading at the top of the page:

Event Manager

+ Summary

|~ boite Soecec

The filtering feature is displayed:

Severties Elemant Types
Al Summary T Gentans
Custom TN i1 parioa Unknawn Application
Irifi ional Host
- . i N ;
] Last one day g Switch Element Hame Confoins
Minar Storage System
Major ~ | |Tape Librany il
+ Advancad Dpbens

—|ﬁ

Cleared

T

[ Autemalizaly fkee
evens -

Colapss al evenls with same

severily. type and element

2. Expand the Advanced Options heading.

Once the Advanced Options heading is expanded, the Element Name Contains field becomes
inactive. Any values entered in the Element Name Contains field are ignored while the

Advanced Options heading is expanded.

3. Click the Add button:

Elements

- Filter
Severities Element Types

E::Emﬂm Time Period Unknown Application

|L ; q 3 Informational Host

Cd as! ane day Warning Switch —
Minor | | Storage System
Major * | | Tape Library bt

+ .ﬁd-.-ff.l_nrcsd Optionz

L,

To fitter eventz for =pecific elements, click "Add’ te specify elements, specify filter criteria and click Fitter q

4. Select the element type you want to add and click Next.
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5. Select one or more elements you want to add to the filter and Next.

Only the elements of the type you specified in the previous window are displayed. For
example, if you selected hosts in the previous window, only hosts are displayed in this screen.

If the element you are looking for does not appear on the first page of the table, use the
navigation tools at the top of the table to page through the list of elements.

The hosts you select are listed in the navigation filter. In the following example, Host_13081
and Host_10380 were selected for advanced filtering, so they are listed under the Advanced
Filtering heading:

Event Manager

+ Summary
- Filter
Severitiez Element Types
2 Summary Text Containz
Time Period Informational || |Host B | |

Switch

Storage System —
Fabric | |
Application b

Minor

Major

Warning

Critical b

Last one day  + Element Name Contains

- Advanced Options

Elements

Dele
Host_13081 (discovered) |7 m Clear Data

Host_10380 (discovered) (7

Delete Selected Delete All Clear Selected Clear All

6. Verify that the Advanced Options heading is expanded as shown in the following figure, or

advanced filtering will not work.

- Advanced Options

Elements

Dele
Host_13081 (discovered) []] m Clear Data

Host_10380 (discovered) [T

. Click the Filter button.

Event Manager displays the elements specified under Advanced Options.
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Clearing Advance Filtering Options

You can clear the filtering set for advanced options, by clicking the Clear Data button under the
Advanced Options heading.

Viewing Event Details

To access event details, click the link for the event under the Summary Text column. You can also
right-click an event and select Event Details from the drop down menu.

The Event Details pane provides information on one or more of the following:

Serial Number — The number assigned to the event
Summary Text — A brief explanation of the event

Element — The source of the event. An element can be a switch, host, application, fabric, or
anything else on the network. If this field is blank, the event did not come from an element.

Source - If the event came from an element, the name of the element is provided.
Time Reported — The time the event was reported to the management server
Probable Cause — An explanation of a probable cause.

Recommended Actions — Recommendations

Event Type — Describes the event

Correlated Indications — Information obtained from the provider

Severity — The severity level, which can be one of the following:

= Clear

= Unknown

= |nformational
= Warning

= Minor

= Major

n Critical

Sorting Events

To sort events, click the column title corresponding to the attribute you want to sort the event. For
example, to sort events by time, click the Time heading on the table on the Events tab. The events
are sorted by time on the Events page.
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Viewing Topology for a File Server

To view the topology for afile server:

1. Click File System Viewer ( ES\ )in the left pane.
2. Select afile server, as described in "Setting a Context" on page 47.

3. Select the Topology view in the right pane.

_Context: File BROCADI

J File Server BROCADEPROXY4 &) &, 100% || &,

: 1
« BROCADEPROXY4 ,J BROCADEPROXY4
F= Application Path - C:
= Application Path - E:

Fila Sarvar
S Application Path - F: !
E= Application Path - G:

E Application Path - H: BROCADEPROXY4
= Application Path - 5:
HOST
=
q:
MSET
t*_
BROCADEPROXY4

Note: You cannot view the topology for a file server created on host clusters. The
following message is displayed when you access the Topology view: There are no

paths.

Scan Status for File Servers

The Scan Status view displays detailed information from the scans for a file server. This
information is also available from the Scan Status tab, which you can access by selecting
Configuration > File System Viewer. You can also see information for other file servers. For
detailed information about scan status information, see "Scan Status Tab" on page 25.

To view the scan status for a file server:
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1. Click File System Viewer ( E\ )in the left pane.
2. Select afile server, as described in "Setting a Context" on page 47.

3. Select the Scan Status view.

Scan Schedule for File Servers

The Scan Schedule view displays the scheduled scans for afile server. This information is also
displayed in the Scheduled Scan tab accessible from the Configuration > File System Viewer
menu. You will also see information for other file servers. For more detailed information about scan
schedules, see "Scheduling Single and Multiple Scans" on page 15.

To view the scan status for a file server:

1. Click File System Viewer ( E\ )in the left pane.
2. Select afile server, as described in "Setting a Context" on page 47.

3. Select the Scan schedule view.
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Individual Volume Details

This section consists of the following topics:

"Dashboard Information for a Volume" below
"Properties for a Volume" on page 96

"File System Details for a Volume" on page 97
"Extensions on Volumes" on page 99

"Aging Information for a Volume" on page 100
"File Sizes on a Volume" on page 101

"Users on a Volume" on page 102

"Ownership Information for a Volume" on page 103
"Trustee Information for a Volume" on page 104
"Scan Status for Volumes" on page 104
"Explorer View" on page 105

"Directory Dashboard Details on a Volume" on page 106

Dashboard Information for a Volume

The dashboard displays the following information for volumes.

Summary

A graph is represented in one of the following ways:

= [f all large directories are less than 1 MB, the pie chart has only two sectors, Free and Used.

= If there are several large directories with a size larger than 1 MB, the pie chart has one sector
for Free, eight sectors for the top eight directories, and one sector for Used (Rest).

A summary table to the right of the graph displays:

Total Storage— The capacity of the volume.

Used — The amount of used space on the volume.

Free — The amount of free space on the volume.

Scanned Space — The total size of the files that are scanned by File System Viewer.
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= Capacity — The size of the volume.

= Used % — The percentage of used space on the volume.

= Free % — The percentage of free space on the volume.

= File System — Type of the file system on the volume.

= Number of Files — Total number of files on the volume.

= Number of Directories — Total number of file on the volume.

Top ten extensions by size displays the top 10 file extensions that take up the most space in
gigabytes. To see a full-page view, access Extensions view for the Enterprise context, as
described in "Extensions on Volumes" on page 99.

Aging displays the (gigabyte) size of files modified or used within the following periods:
e 0-30days

e 30-60 days

e 60-90 days

e 90-180 days

e 180 days-1year
e 1-2years

e 2-3years

o 3-4years

e 4-5years

e 5+ year

For example, if two 3-GB files were modified within the last 30 to 60 days, 6 GB would be
displayed for the 30-60 day label.

Sizing displays the number of files modified within the following period:

o 0-30days

e 30-60 days

e 60-90 days

e 90-180 days

o 180 days-1year
e 1-2years

e 2-3years
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3-4 years
4-5 years

5+ years

For example, if two 3-GB files were modified within the last 30 to 60 days, two would be displayed
for the 30-60 day label.

To access the dashboard:

1

2
3.
4

Click File System Viewer ( ﬁ )in the left pane.

Select a volume, as described in "Setting a Context" on page 47.
Select Dashboard from the Select View menu.

Click Go.

To refresh data in a pane, click the Refresh button ( ) in the upper-left corner of the pane.

Properties for a Volume

To view the properties for afile server:

1.
2.

3.

Click File System Viewer ( E\ ) in the left pane.
Select a volume, as described in "Setting a Context" on page 47.

Select Properties from the Select View menu.

The Properties page displays the following information:

Contacted* — The last time the software contacted the file server.

File System Type* — The type of file system on the volume, such as New Technology File
System (NTFS)

Block Size*

Discovery Status™ — The status of the last discovery. If the element was just discovered, the
status is at “created.”

Consumable Blocks

Number of Blocks*

Remote Storage*

Record Created* — When a record was created for the file server
Device ID*

Total Space*

Data Organization
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e Description*

e Access

e Host* — The name of the host

e Business Cost (per hour) — The business cost that was set at the top of this page
¢ Disk Drives* —The drive(s) associated with the volume

e Disk Partitions* — Partitions on the volume

*Populated fields. By default, the other fields are blank.

File System Details for a Volume

To view the properties of the volumes on a file server:

1. Click File System Viewer ( ﬁ )in the left pane.
2. Select avolume, as described in "Setting a Context" on page 47.

3. Select File System Info from the Select View menu.
The following are displayed.
A chart, which appears in one of the following ways:

o If all large directories are less than 1 MB, the pie chart has only two sectors: Free and Used.

o [f there are several large directories with a size larger than 1 MB, the pie chart has one sector for
Free, eight sectors for the top eight directories, and one sector for Used (Rest).

To the right of the chart, a summary table displaying:

Total Storage — The capacity of the volume

e Used — The amount of used space on the volume

¢ Free — The amount of free space on the volume

¢ Scanned Space — The total size of the files that are scanned by File System Viewer
e Capacity — The size of the volume

o Used % — The percentage of used space on the volume

¢ Free % — The percentage of free space on the volume

¢ File System — Type of the file system on the volume

e Number of Files — Total number of files on the volume

¢ Number of Directories — Total number of file on the volume

Below the chart, the following tabs:
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o Largest Directories — Lists the largest directories on the volume first.

File System Viewer provides the following for each directory: size of the directory, number of
files in the directory, and number of subdirectories in the directory. This table lists only the files
and directories directly contained in the directory in question and not those in the subdirectories.
Click the hyperlink on the directory name to display a summary snapshot of the directory where
the Aging, Extension, Size, Largest Files, and Aged Files information is presented.

o Largest Files — Lists the directories with the largest files on the volume first. File System
Viewer displays the name of the file, its size, and the accessed, modified, and created time.

e Aged Files — Shows information about the age of the directories on the volume, including:

= Name of thefile

= |ts size

= Owner

= Lastaccessed

= Last modified

= Created

= Attributes, as described in "Viewing Attribute Details" on page 70

o Largest Temp Files — Displays the largest temporary directories. File System Viewer provides
the following information:

= Name of the file

= [ts size

= Owner

= Lastaccessed

= Last modified

= Created

= Attributes, as described in "Viewing Attribute Details" on page 70

The time and date the file was last accessed. If the table displays information, either the
extension group TEMP does not exist orFile System Viewer could not find any temporary files. If
no TEMP extension group is found, you can create the extension group, name it TEMP, and map
all temporary file extensions.

o Duplicate Files — Displays the following duplicate file data:

= Name of file
n Size of file

= Owner
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» Lastaccessed

= Last modified

= Created

= Attributes, as described in "Viewing Attribute Details" on page 70

If no duplicate file data is found for the volume, one of the following may have occurred:

¢ Norule was created.
¢ A volume was not mapped to the duplicate report rule.

e No duplicate file exists.

Extensions on Volumes

The Extensions view provides information about the types of files on a volume. For example, it can
let you know how many mpgs are stored on a file volume and their file size. In the extensions tab,
there is a drop-down menu to select Extension Groups, in which files are grouped by file type.

To view information about file extensions on a server:

1. Click File System Viewer ( E\ )in the left pane.
2. Select a volume (see "Setting a Context" on page 47).

3. Select Extensions from the Select View menu. The following are displayed:

= A graph displaying the top 10 extensions and their size. Data less than 1 MB is not
displayed in the graph. This could result in an empty graph if all data points are less than 1
MB.

= A table below the graph displaying the extension and its properties:

o Size - The size of all the files with that extension. This property shows you which types
of files are using the most space on a volume.

o Count— The number of files with this extension

4. Tofilter by extension, enter the extension name and click the Submit button.
See "Providing Expressions for the Filter Fields" on page 51 for more information.

5. Toview the extension groups for a volume, select the Extension Group filter.
See "Viewing Extension Groups" on page 52 for more information about creating, viewing, and
removing extension groups.

6. Toview alisting of the files with the extension on the volume, click a volume in the Volume
column in the table. The largest N and most aged N files with the extension are listed in the
Largest Files and Aged Files tabs. The filename with path, size, and the accessed, modified,
and created time are provided.

Extensions at the File Level

To view extensions at the file level:
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Click File System Viewer ( E\ )in the left pane.
Select a volume, as described in "Setting a Context" on page 47.

Select Extensions from the Select View menu.

A 0w N~

Click an extension in the table. File System Viewer displays Largest Files and Aged Files tabs,
which provide the following information:

= File name

= Size

= Owner

= Lastaccessed

= Last modified

= Created

= Attributes — See "Providing Expressions for the Filter Fields" on page 51.

5. To export the information to a comma, separated list, click Export files to CSV.

Excel can only handle a limited number of records. If the CSV file will not open in Excel, you might
have to bring the CSV file into a database. Or you could break the CSV file into smaller pieces that
Excel can handle.

Aging Information for a Volume

To view aging information for a volume:

1. Click File System Viewer ( ﬁ )in the left pane.

2. Select avolume, as described in "Setting a Context" on page 47.
3. Select the Aging view in the right pane.
By default, the page displays the following:

e A graph that displays the size of files (in gigabytes) that were modified or used within the
following time periods:
= 0-30days

= 30-60 days

= 60-90 days

= 90-180 days

= 180 days-1year
= 1-2years

= 2-3years
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= 3-4years
= 4-5years
= 5+ years

For example, if two 3-GB files were modified within the past 30 to 60 days, 6 GB is displayed for
the 30-60 day label.

A table displaying the number of files (and their size in megabytes) that were accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph. To view this table, click the plus sign (+) to the left of the Show/Hide Aggregated
Summary Details text.

A table displaying, by volume, the number of files (and their size in megabytes) that were
created, modified, or accessed within the specified time period. To determine which type of
information to display in the table, select Accessed, Modified, or Created from the Age
Distribution since last menu and then click Submit.

Aging Properties for Individual Files

To view the aging properties for a particular file:

A w0 N~

5.

Click File System Viewer ( E\ )in the left pane.
Select a volume, as described in "Setting a Context" on page 47.

Select the Aging view in the right pane.

Click the heading of an age group in the table. A table appears with the following information for
the files in the age group:
= Size

= Owner

= Lastaccessed

= Last modified

= Created

= Attributes (see "Viewing Attribute Details" on page 70 for more information)

To save the aging details to a comma-separated list (CSV file), click Export files to CSV.

File Sizes on a Volume

To view information about file sizes on a volume:

1.
2.

3.

Click File System Viewer ( E\ ) in the left pane.
Select a volume, as described in "Setting a Context" on page 47.

Select the Sizes view in the right pane.

The page displays the following:
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¢ A bar chart displaying the size group distribution by usage or by count depending on the option
selected:

= Usage - The total size of all the files with the particular extension
= Count - The number of files with the particular extension

o Atable listing the number of files and the total size for each size group on each volume

Individual File Sizes

To view detailed information about individual file sizes on a volume:

Click File System Viewer ( E\ )in the left pane.
Select a volume, as described in "Setting a Context" on page 47.

Select the Sizes view in the right pane.

A 0w D~

To obtain more detailed information about a size group, click its corresponding heading in the
table.

A table is displayed showing the following information about each file in the size group:
e Size

e Owner

e Lastaccessed

e Last modified

e Created

o Attributes (see "Viewing Attribute Details" on page 70)

Dataless than 1 MB is not displayed in the graphs. This could result in an empty graph if all the data
points are less than 1 MB.

To save the details to a comma-separated list (CSV file), click Export files to CSV.

Users on a Volume

To view information about users on a volume:

1. Click File System Viewer ( E\ )in the left pane.
2. Select avolume, as described in "Setting a Context" on page 47.

3. Select Users from the Select View menu.

The user account names displayed on this page are obtained by the following methods:
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¢ The management server scanning the file servers

o Information imported through LDAP servers (see "Importing User Information from LDAP and
Active Directory Servers" on page 27

e Users created through the Create User tool in File System Viewer (see "Adding File System
Viewer Users" on page 57).

The page displays the following:

o A graph showing the top five users by usage and the amount of space they use

e A summary table to the right of the graph displaying the following:

Users — The number of users assigned to all of the file servers monitored
Users Size — The amount of space the users use
Largest User — The user who uses the most space

Largest User Size — The amount of space the largest user uses

o A table below the graph displaying the users and the following properties:

User ID — The ID of the user
User Name — The name of the user

Home Directory — The home directory of the user. The home directory is assigned to a user
by the user’s organization. By default, the user has full access rights (read, write, execute) to
the home directory. A user can have multiple home directories.

Owner — The owners who are associated with the user. A user can have multiple owners.

Department Number — The number of the department to which the user is assigned. The
department number was entered when the department was created in Chargeback.

User Status™ — The user’s status. User Status information will be displayed for users
retrieved from Active Directory; however, the Edit option will not be displayed for them.

Manager* — The name of the user’'s manager
Quota — The amount of space the user is allocated

Used- The amount of space the user is using

*The User Status and Manager columns are populated when the information is imported from an
LDAP server. Users cannot add this information from within HP Storage Essentials.

To display the properties of just one user account or provide a wild cars, enter the full name in the
Filter box, and then click Submit. For more information, see "Providing Expressions for the Filter
Fields" on page 51.

Ownership Information for a Volume

To view ownership information for a volume:
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1. Click File System Viewer ( E\ )in the left pane.
2. Select avolume, as described in "Setting a Context" on page 47.

3. Select Ownership from the Select View menu.
The following is displayed for the file server:
e A graph showing the top 10 owners who use the most in megabytes (MB)
o Atable displaying:
= Ownership — The security identifier (Windows) or user identifier (UNIX)
= Size —The total size of the files the security identifier or user identifier uses

= Files — The files that the security identifier or user identifier uses

Tofilter by owner or by expression, enter the information in the Filter field, and click Submit.

For more information about filtering by expressions, see "Providing Expressions for the Filter
Fields" on page 51.

Trustee Information for a Volume

The Trustee view provides the following:
e A graph listing the top 10 trustees by size

o Atable listing the following for each trustee:

s Size
= Directories

To access the Trustee view:

1. Click File System Viewer ( E\ )in the left pane.
2. Select avolume, as described in "Setting a Context" on page 47.

3. Select Trustee from the Select View menu.

To filter the information for one or more trustee, provide the name of the trustee or provide an
expression in the Filter field and then click Submit. For more information about expressions, see
"Providing Expressions for the Filter Fields" on page 51.

For information about how the trustee data is collected, see "How Data is Calculated in the Trustee
View" on page 69.

Scan Status for Volumes

The Scan Status view displays detailed information from the scans for a volume. This information is
also available from the Scan Status tab, which you can access by selecting Configuration > File
System Viewer. You can also see information at the level of the file server. For detailed information
about scan status information, see "Scan Status Tab" on page 25.
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Explorer View

The Explorer view provides the following information.
A table with the following information about the directories on the volume:
e Current directory information:

= Size of the current directory in megabytes
= Number of directories in the current directory
= Number of files in the current directory

e Current directory and subdirectories information:
= Size of the current directory and its subdirectories in megabytes

= Number of directories in the current directory and its subdirectories in megabytes
= Number of files in the current directory and its subdirectories in megabytes

¢ When the current directory was created

e When the current directory was modified

e When the current directory was last accessed

o Attributes of the current directory (see "Viewing Attribute Details" on page 70)

A table listing the files at the top-level of the current directory, including:

Size in megabytes

e Owner

e When the file was created

o When the file was last modified

e When the file was last accessed

o Attributes of the file (see "Viewing Attribute Details" on page 70

On Windows, the file owner listed for an encrypted file is the account running the CIM extension
service (usually the host's local administrator account).

To view the directory’s files and subdirectories, click the name of the directory in the first table:
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To access the Explorer view:

1. Click File System Viewer ( Ea )in the left pane.
2. Select avolume, as described in "Setting a Context" on page 47.

3. Select Explorer from the Select View menu.

Directory Dashboard Details on a Volume

To view directory dashboard details:

1. Click File System Viewer ( ES\ )in the left pane.
2. Select avolume, as described in "Setting a Context" on page 47.
3

. Select Explorer from the Select View menu.
4. Click the Directory Dashboard Details link located above the first table.

File System Viewer provides the following detailed information at your fingertips in the directory
dashboard details page for files.

The Directory Dashboard provides the directory size and the number of files in the directory. This
information can be found under the name of the directory:
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Total Used: 1,152 MB Total Files: 14

Export files to CSV

When you access the Directory Dashboard, you are shown the following tabs:

e Aging - Displays the number of files and their size (in megabytes) that were accessed,
modified, and created in the specified time periods, which are the same as those listed in the
graph.

o Extensions — Displays the extension and its properties:

= Size —The size of all the files with that extension. This property lets you see which types of
files are using the most space on a volume.

= Count— The number of files with this extension.
¢ Sizes - Lists the number of files and the total size for each size group on each volume.

o Aged Files - Lists the following properties of afile:

= Size

= Owner

= When the file was last accessed

= When the file was last modified

= When the file was created

= Attributes. See "Viewing Attribute Details" on page 70 for more information.

Files are listed by age with the oldest files displayed first.
o Largest Files — Lists the following properties of afile:

= Size

= Owner

= When the file was last accessed

= When the file was last modified

= When the file was created

= Attributes. See "Viewing Attribute Details" on page 70 for more information.

Files are listed by size with the largest files displayed first.

o Trustee — Lists the following for each trustee:
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= Trustee’s Share

= Permissions
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We appreciate your feedback!

If an email client is configured on this system, by default an email window opens when you click
here.

If no email client is available, copy the information below to a new message in a web mail client,
and then send this message to docfeedback@hp.com.

Product name and version: HP Storage Essentials, 9.70
Document title: File Servers Guide

Feedback:
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